## Contents

### WARNINGS
- Safety Information ................................................. ix
- Read Me First! ....................................................... x
- Hazards and Warnings .............................................. x

### 1 3D Printer Software .............................................. 13
  1.1 Software Overview ............................................. 14
  1.2 Software Types ................................................ 14
  1.3 Installing Drivers .............................................. 15
  1.4 Cura ............................................................ 15
  1.5 Quick Print Settings ........................................... 17
  1.6 View Options ................................................... 21
  1.7 Starting Your First Print ...................................... 25
  1.8 Removing Your First Print .................................... 27
  1.9 Full Settings .................................................. 28
  1.10 Basic Tab Options ............................................. 29
  1.11 Advanced Tab Options ........................................ 33
  1.12 Plugins ....................................................... 36
  1.13 Start and End Gcode Settings ................................. 38
  1.14 Expert Settings ................................................ 38
  1.15 Retraction ..................................................... 39
  1.16 Skirt .......................................................... 39
  1.17 Cool ............................................................ 40
  1.18 Support ........................................................ 41
  1.19 Black Magic .................................................... 42
  1.20 Brim ............................................................ 42
  1.21 Raft ............................................................. 43
  1.22 Fix Horrible .................................................... 44
  1.23 Dual Extrusion ................................................ 45
# CONTENTS

1.24 Printrun ........................................ 50  
1.25 Using Printrun ................................. 52  
1.26 CAD and 3D Modeling Software .......... 56  
1.27 Alternative Printer Host Software ....... 57  

2 Slic3r ............................................ 59  
2.1 Introduction ................................... 60  
2.2 Getting Slic3r ................................ 61  
2.3 First Print .................................... 62  
2.4 Simple Mode .................................. 79  
2.5 Expert Mode .................................. 88  
2.6 Configuration Organization ............... 117  
2.7 Repairing Models .................... .......................... 119  
2.8 Advanced Topics .............................. 120  
2.9 Troubleshooting .............................. 133  
2.10 Slic3r Support ............................... 138  

3 Printing with the Graphic LCD .............. 141  
3.1 GLCD Controller, Cura or Printrun Host? 142  
3.2 Multiple Connections ....................... 142  
3.3 Putting Print Files on the SD Card ........ 143  
3.4 Printing With the Graphic LCD ............ 144  

4 Maintaining Your 3D Printer ................. 147  
4.1 Overview ..................................... 148  
4.2 Smooth Rods .................................. 148  
4.3 Lead Screw Drive Rods ................. .......................... 148  
4.4 PEI Surface .................................. 148  
4.5 Hobbed Bolt .................................. 149  
4.6 Belts ......................................... 149  
4.7 Hot End ...................................... 149  
4.8 Electronics .................................. 149  

5 Advanced Usage ............................... 151  
5.1 Intro ......................................... 152  
5.2 Changing nozzles .............................. 152  
5.3 Bed Adhesion ................................ 152  
5.4 Using 1.75mm filament ..................... 153  

6 Hardware and Software Source Code ....... 155
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>3D Printer Support</td>
<td>157</td>
</tr>
<tr>
<td></td>
<td>7.1 LulzBot</td>
<td>158</td>
</tr>
<tr>
<td></td>
<td>7.2 Community</td>
<td>158</td>
</tr>
<tr>
<td>8</td>
<td>Warranty Information</td>
<td>159</td>
</tr>
<tr>
<td></td>
<td>8.1 Warranty</td>
<td>160</td>
</tr>
<tr>
<td>9</td>
<td>Contact Information</td>
<td>161</td>
</tr>
<tr>
<td></td>
<td>9.1 Support</td>
<td>162</td>
</tr>
<tr>
<td></td>
<td>9.2 Sales</td>
<td>162</td>
</tr>
<tr>
<td></td>
<td>9.3 Websites</td>
<td>162</td>
</tr>
<tr>
<td>Index</td>
<td></td>
<td>163</td>
</tr>
<tr>
<td>Glossary</td>
<td></td>
<td>169</td>
</tr>
<tr>
<td>Figure</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>1.1</td>
<td>Quick Print Settings</td>
<td>17</td>
</tr>
<tr>
<td>1.2</td>
<td>Options after selecting model</td>
<td>19</td>
</tr>
<tr>
<td>1.3</td>
<td>Rotating your Model</td>
<td>20</td>
</tr>
<tr>
<td>1.4</td>
<td>Scaling your Model</td>
<td>21</td>
</tr>
<tr>
<td>1.5</td>
<td>View in Normal Mode</td>
<td>22</td>
</tr>
<tr>
<td>1.6</td>
<td>View in Overhang</td>
<td>22</td>
</tr>
<tr>
<td>1.7</td>
<td>View in Ghost</td>
<td>23</td>
</tr>
<tr>
<td>1.8</td>
<td>View in Xray</td>
<td>23</td>
</tr>
<tr>
<td>1.9</td>
<td>View in Layers</td>
<td>24</td>
</tr>
<tr>
<td>1.10</td>
<td>Viewing Cumulative Layers</td>
<td>24</td>
</tr>
<tr>
<td>1.11</td>
<td>Viewing Specific Layers</td>
<td>25</td>
</tr>
<tr>
<td>1.12</td>
<td>Control Screen</td>
<td>26</td>
</tr>
<tr>
<td>1.13</td>
<td>View in Full Settings</td>
<td>28</td>
</tr>
<tr>
<td>1.14</td>
<td>Differences in Layer Height</td>
<td>29</td>
</tr>
<tr>
<td>1.15</td>
<td>Support Types</td>
<td>32</td>
</tr>
<tr>
<td>1.16</td>
<td>Cutoff Example</td>
<td>35</td>
</tr>
<tr>
<td>1.17</td>
<td>View of Plugins</td>
<td>37</td>
</tr>
<tr>
<td>1.18</td>
<td>View Expert Settings</td>
<td>38</td>
</tr>
<tr>
<td>1.19</td>
<td>Before Merge</td>
<td>48</td>
</tr>
<tr>
<td>1.20</td>
<td>After Merge</td>
<td>49</td>
</tr>
<tr>
<td>1.21</td>
<td>Printrun application for 3D printer control</td>
<td>50</td>
</tr>
<tr>
<td>1.22</td>
<td>Printrun</td>
<td>52</td>
</tr>
<tr>
<td>1.23</td>
<td>Printrun Functions</td>
<td>54</td>
</tr>
<tr>
<td>1.24</td>
<td>Movement Controls</td>
<td>54</td>
</tr>
<tr>
<td>2.1</td>
<td>Configuration Wizard: Welcome Screen</td>
<td>64</td>
</tr>
<tr>
<td>2.2</td>
<td>Configuration Wizard: Firmware Type</td>
<td>65</td>
</tr>
<tr>
<td>2.3</td>
<td>Configuration Wizard: Bed Size</td>
<td>66</td>
</tr>
<tr>
<td>2.4</td>
<td>Configuration Wizard: Nozzle Diameter</td>
<td>67</td>
</tr>
<tr>
<td>2.5</td>
<td>Configuration Wizard: Filament Diameter</td>
<td>68</td>
</tr>
<tr>
<td>2.6</td>
<td>Configuration Wizard: Extrusion Temperature</td>
<td>69</td>
</tr>
<tr>
<td>2.7</td>
<td>Configuration Wizard: Bed Temperature</td>
<td>70</td>
</tr>
<tr>
<td>2.8</td>
<td>Configuration Wizard: End</td>
<td>71</td>
</tr>
<tr>
<td>2.9</td>
<td>Shapesmith online CAD tool</td>
<td>75</td>
</tr>
<tr>
<td>Figure</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>------</td>
</tr>
<tr>
<td>2.10</td>
<td>Plater</td>
<td>76</td>
</tr>
<tr>
<td>2.11</td>
<td>Minimug model</td>
<td>77</td>
</tr>
<tr>
<td>2.12</td>
<td>STL file loaded</td>
<td>77</td>
</tr>
<tr>
<td>2.13</td>
<td>Preferences</td>
<td>79</td>
</tr>
<tr>
<td>2.14</td>
<td>Simple Mode: Print Settings</td>
<td>80</td>
</tr>
<tr>
<td>2.15</td>
<td>An example of insufficient top layers</td>
<td>81</td>
</tr>
<tr>
<td>2.16</td>
<td>Creating a vase from a solid model</td>
<td>82</td>
</tr>
<tr>
<td>2.17</td>
<td>An example of an object printed with support material</td>
<td>83</td>
</tr>
<tr>
<td>2.18</td>
<td>An example of brim</td>
<td>84</td>
</tr>
<tr>
<td>2.19</td>
<td>Simple Mode: Filament Settings</td>
<td>85</td>
</tr>
<tr>
<td>2.20</td>
<td>Simple Mode: Printer Settings</td>
<td>86</td>
</tr>
<tr>
<td>2.21</td>
<td>Expert mode speed options</td>
<td>89</td>
</tr>
<tr>
<td>2.22</td>
<td>Infill pattern settings</td>
<td>92</td>
</tr>
<tr>
<td>2.23</td>
<td>Infill pattern: Line (344.51mm / 5m:20s)</td>
<td>92</td>
</tr>
<tr>
<td>2.24</td>
<td>Infill pattern: Rectilinear (350.57mm / 5m:23s)</td>
<td>92</td>
</tr>
<tr>
<td>2.25</td>
<td>Infill pattern: Concentric (351.80mm / 5m:30s)</td>
<td>93</td>
</tr>
<tr>
<td>2.26</td>
<td>Infill pattern: Honeycomb (362.73mm / 5m:39s)</td>
<td>93</td>
</tr>
<tr>
<td>2.27</td>
<td>Infill pattern: Hilbert Curve (332.82mm / 5m:28s)</td>
<td>93</td>
</tr>
<tr>
<td>2.28</td>
<td>Infill pattern: Archimedean Chords (333.66mm / 5m:27s)</td>
<td>94</td>
</tr>
<tr>
<td>2.29</td>
<td>Infill pattern: Octagram Spiral (318.63mm / 5m:15s)</td>
<td>94</td>
</tr>
<tr>
<td>2.30</td>
<td>Infill pattern comparison in a complex object. Left to Right: honeycomb, line</td>
<td>94</td>
</tr>
<tr>
<td>2.31</td>
<td>Infill patterns at varying densities. Left to Right: 20%, 40%, 60%, 80%. Top to Bottom: Honeycomb, Concentric, Line, Rectilinear, Hilbert Curve, Archimedean Chords, Octagram Spiral</td>
<td>95</td>
</tr>
<tr>
<td>2.32</td>
<td>Infill advanced settings</td>
<td>96</td>
</tr>
<tr>
<td>2.33</td>
<td>Retraction settings</td>
<td>97</td>
</tr>
<tr>
<td>2.34</td>
<td>Skirt settings</td>
<td>99</td>
</tr>
<tr>
<td>2.35</td>
<td>Cooling strategy</td>
<td>101</td>
</tr>
<tr>
<td>2.36</td>
<td>Cooling advanced settings</td>
<td>102</td>
</tr>
<tr>
<td>2.37</td>
<td>Support structure options</td>
<td>104</td>
</tr>
<tr>
<td>2.38</td>
<td>Minimug model, tilted 45°</td>
<td>105</td>
</tr>
<tr>
<td>2.39</td>
<td>Support infill pattern: Rectilinear</td>
<td>105</td>
</tr>
<tr>
<td>2.40</td>
<td>Support infill pattern: Rectilinear Grid</td>
<td>105</td>
</tr>
<tr>
<td>2.41</td>
<td>Support infill pattern: Honeycomb</td>
<td>106</td>
</tr>
<tr>
<td>2.42</td>
<td>Example of pattern angle rotated 45°</td>
<td>106</td>
</tr>
</tbody>
</table>
2.43 Multiple extruder options - Printer Settings Tab (General).
Note the two extruders defined in the left-hand pane. 107
2.44 Multiple extruder options - Printer Settings Tab (Extruder). 107
2.45 Plater with multiple filament options. 108
2.46 Multiple extruder options - Print Settings Tab. 109
2.47 Multiple extruder options - Tool change G-code. 110
2.48 Extrusion widths options. 111
2.49 Example model highlighting use case for variable layer heights. 112
2.50 Example with normal layer height. 113
2.51 Variable layer height options - Info. 114
2.52 Variable layer height options - Layers. 115
2.53 Example with variable layer height. 115
2.54 Example print with variable layer height. 116
2.55 Example with skipped layers. 116
2.56 Saving a profile. 118
2.57 Deleting a profile. 118
2.58 FreeCAD part repair. 119
2.59 Sequential printing options. 120
2.60 The clearance cylinder around an extruder. 121
2.61 Post-processing script option. 127
2.62 Example post-processing script to display Slic3r environment variables. 127
2.63 Example post-processing script to print each line to output. 128
2.64 Extrusion Width. 129
2.65 Bridging filament shape. 130
2.66 Extrusion shape. 131
2.67 No path overlap. 131
2.68 Holes made through polygonal segments. 134
2.69 Z wobble changing layer stacking. 135
2.70 Variable filament diameter changing layer stacking. 135
3.1 GLCD Info Screen 143
3.2 Main Menu 145
WARNINGS
Safety Information
WARNING!

Read Me First!

READ THIS MANUAL COMPLETELY BEFORE UNPACKING AND POWERING UP YOUR PRINTER.

Hazards and Warnings

Your LulzBot™ TAZ 3D printer has motorized and heated parts. Always be aware of possible hazards when the printer is operational.

Electric Shock Hazard

Never open the electronics case when the printer is powered on. Before removing the electronics case cover always power down the printer and completely turn off and unplug the power supply. Allow the power supply to discharge for at least one minute.

Burn Hazard

Never touch the extruder nozzle or heater block without first turning off the hot end and allowing it to completely cool down. The hot end can take up to 20 minutes to completely cool. Never touch recently extruded plastic. The plastic can stick to your skin and cause burns. The heated bed can reach high temperatures that are capable of causing burns.

Fire Hazard

Never place flammable materials or liquids on or near the printer when it is powered on or operational. Liquid acetone and vapors are extremely flammable.

Pinch Hazard

When the printer is operational take care to never put your fingers in any moving parts including belts, pulleys, or gears. Tie back long hair or clothing that can get caught in the moving parts of the printer.
HAZARDS AND WARNINGS

Static Charge

Make sure to ground yourself before touching the printer, especially its electronics. Electrostatic discharge can damage electronic components. Ground yourself by touching a grounded source like your computer case.

Age Warning

For users under the age of 18, adult supervision is recommended. Beware of choking hazards around small children.

Modifications and Repairs Warning

At Aleph Objects, Inc.® we respect your freedom to modify your LulzBot™ desktop 3D printer. However any modifications or attempted repairs that cause damage are not covered under the Warranty. Questions? Contact Technical Support by emailing support@lulzbot.com, or by calling +1-970-377-1111.

Federal Communications Commission Statement

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

This device complies with part 15 class A of the FCC Rules. Operation is subject to the following two conditions:

1. This device may not cause harmful interference and

2. This device must accept any interference received, including interference that may cause undesired operation.
FCC Warning: Changes or modifications not approved by the party responsible for compliance could void the users authority to operate the equipment.
3D Printer Software
1.1 Software Overview

Aleph Objects, Inc., the maker of the LulzBot™ TAZ 3D printer, completely supports Free/Libre software and hardware. Along with the LulzBot™ TAZ 3D printer being a Free/Libre hardware design, has been tested to work with 100% Free/Libre software. Our source code and design files are hosted on our development server found at http://devel.lulzbot.com. To operate your desktop 3D printer you will need to install a few software packages onto your PC. You will need a 3D printer host, an .STL to .gcode generator, and optional CAD or 3D modeling software.

1.2 Software Types

Printer Hosts

Printer Host software is used to control the 3D printer. The program not only allows you to manually move the printer along all the axes, but set temperatures manually, send commands, and receive feedback/error messages from the onboard electronics. We recommend that new users start with Cura as it includes a slicing engine as well.

Common Printer Hosts:
- Cura
- Printrun (Pronterface)
- MatterControl
- OctoPrint
- BotQueue

Slicers

These programs take the 3-Dimensional model (typically STL/OBJ/etc) and determine the 3D printer toolpath based on the options selected. The slicing engine uses the nozzle diameter, movement speeds, layer height, and other variables to determine the coordinates where it needs to move, and the rates at which it will do so. This information is exported out of the program as a gcode file. The gcode file is a plain-text file with a series of text-based codes and a list of the complete X,Y, and Z axis coordinates used for printing.
the 3D model. We recommend that new users start with Cura as it includes the printer host as well.

Recommended Slicers:

- Cura
- Slic3r

All of the following Free/Libre software packages are available for GNU/Linux, Windows, and Apple OS X. However, we highly recommend using these programs on GNU/Linux.

The required software can be found in the Support/Downloads section at LulzBot.com/support/downloads. You will also find instructions there for installing each program onto your PC. You can also find downloads specific to the LulzBot™ TAZ 3D printer on the LulzBot™ TAZ product page.

1.3 Installing Drivers

Linux and Mac OS X users will not need to install a driver to communicate with the LulzBot™ TAZ 3D printer. Windows users will need to install the drivers. Using Cura as your printer host and slicing software is recommended, as the drivers will automatically be installed during the Cura installation process. The drivers can also be downloaded from LulzBot.com/support/downloads. A visual guide showing the driver installation process can be found in our download section as well.

1.4 Cura

Setup Cura

Cura is available for download on our website at http://LulzBot.com/cura. When installing, it is recommended to uninstall any previous versions of Cura you may have been using. When first opening Cura, you will be prompted to go through the First run wizard. This will consist of selecting your printer, hot end type, extruder type, and then your nozzle size.
It is important to select the correct printer, hot end, tool head, and nozzle size as Cura uses custom profiles and machine settings based upon which printer, hot end, tool head, and nozzle you are running.

- Download the appropriate installer for your computer operating system. Instructions on installation for each operating system is available at http://LulzBot.com/cura.

- Install Cura by double clicking on the installer.

- Click through the install wizard until it completes.

- Start Cura by launching it from your list of installed applications. If this is the first time that Cura has been used the “Configuration Wizard” window will open.

- Select LulzBot TAZ 4 or 5, then select Next.

- Select Stock TAZ 5 (PEI and Hex V2). Press Next.

- Choose the correct nozzle size for your machine. Your TAZ 5 comes with a 0.5mm nozzle standard.

- Select finish.
1.5 Quick Print Settings

After setting up Cura for the first time, you will be shown the main interface screen. (Fig. 1.1, page 17):

Selecting a Quick Print Profile

The print quality settings can be found in the top left-hand corner of the window. For most filaments, there will be Standard, High Speed, and High Detail options. Some of the more exotic filaments may only have a Normal/Standard profile.

High Detail
Designed to give greater detail and finer objects. This will have a smaller layer height, which will make each layer thinner, so that curves seem more natural and walls seem less noticeable. This setting will also require more layers to be laid down, increasing overall print time.

Standard
Designed to give a medium resolution, by increasing the layer height
and print speeds. This will make the organic curves slightly more step-like than the fine setting, but will reduce printing time.

High Speed
Designed for the fast prints, where overall model finish is not of concern. Most commonly used for quick iteration of designs found in rapid prototyping.

Material Selection
Choose your desired filament. The TAZ ships with a 1 meter sample of ABS, that should be used in your first print.

Printing Support Material
The TAZ 3D printer is able to print models that have angles and overhangs, even without support material depending on the overhang distance and angle. Turn this option on if your model could benefit from support material.

Brim
Brim is used to increase surface area of the part you’re printing, thereby ensuring proper part adhesion. This will print a single layer high edge around the outside of the part, helping first layer adhesion and minimizing warping.

Load Model File
Select the STL model you would like to print. Either use the Load Model button or select File > Load Model. Once the file has been loaded, you will see a 3D rendering of your object on the build platform. Select the model to see the various options.

Model Orientation
Move your model to change where it is printed on the build plate. Do this by left clicking on the model and dragging it to the desired location. The
black outlined corner of the 3D print bed view represents the front left hand corner of the build plate on your printer. By holding down the right mouse button and dragging, you can view your model from different angles.

![Figure 1.2: Options after selecting model](image)

**Rotate**

The Rotate button will give you the ability to orient your model in along all three axes. Once you click the rotate button, three circles will surround your model. The red circle will allow you to rotate around the Z axis. The Yellow circle will rotate around the Y axis. The Green circle will rotate around the X axis. Cura defaults to 15 degree increments. Hold Shift to rotate by One Degree Increments.
Lay Flat

The **Lay Flat** button will ensure that the flat portion of your print is securely attached to the bed. It is highly recommended to use this option after rotating your model in the Z direction, as it will help prevent adhesion issues during the print.

Reset

The **Reset** button will return your model to the original orientation as defined by the CAD program used to create the model.

Scale

The **Scale** button displays the model dimensions, along with the ability to scale along the X Y or Z axes. Anything below the number 1.0 will reduce the objects size, while anything above the number 1.0 will increase the objects size. As a default, it will be set to uniform scaling. This will cause the X Y and Z axes to be scaled by the same amount when you make a change to any of them. To disable this, select the lock in the lower section of the scaling window.
1.6 View Options

This mode allows you to view your model in a variety of different ways. This can be helpful for spotting issues before the print even starts.

Normal

This is the standard view and shows the solid outer surfaces of the model. (Fig. 1.5, page 22):
Overhang

Overhang mode shows where your model may need support material. In Fig. 1.6, page 22 the red highlighted areas show overhangs and more severe angles and areas where support material is recommended. The overhang threshold can be defined in Expert Settings.
1.6. VIEW OPTIONS

Ghost

Ghost view mode makes the model translucent to allow you to see what is behind it.

Figure 1.7: View in Ghost

Xray

Xray is very similar to Ghost mode. It will allow you to see into objects, ensuring that inner details are correct.

Figure 1.8: View in Xray
Layers

To view the tool path of your print head and to ensure no skipped layers or gaps use this option. Use the slide bar on the right hand side of the window to move up and down through the tool path layers. Click the icon below it to view an individual layer at a time. If there is support activated in your model, it will be shown in blue.

Figure 1.9: View in Layers

Figure 1.10: Viewing Cumulative Layers
1.7 Starting Your First Print

Once you have your model, profile, and filament loaded, it is time for your first print!

Your TAZ 3D printer has the ability to print directly from a computer using the included USB cable, or directly from the SD card by using the Graphical LCD controller.

Printing from SD Card

Insert the included SD card into your computer. Select File > Save Gcode and choose the SD card location to save your Gcode file to your SD card. Insert the SD Card into the Graphical LCD Controller.

Set Temperature

Turn on the heated bed and hot end by using the Graphical LCD controller and navigating to: Temperature > Select Filament type. If you are using other materials you can set your desired temperatures by going to Temperature > Custom Temp > Nozzle/Bed. Wait for your 3D printer to reach specified temperatures.
Start Print

Once at the desired printing temperature begin your print through your Graphical LCD controller by navigating to: Print From SD > Desired File.

Printing from USB Cable

Connect your 3D printer to a computer using a USB cable, power it on and select the Control button at the top of the 3D viewing window. This will bring up your Pronterface user interface. You will not be able to send any commands until the window title changes to Operational. Once it is operational, you will need to set your filament specific temperatures. The temperature box heats the hot end, while the bed temp sets the bed temperature. Your current temperatures will be listed in the top of the control box. Once your hot end and bed are heated, select Print. This will start the printing process.

Figure 1.12: Control Screen
1.8 Removing Your First Print

After your first print has finished, you need to wait for the part to cool down. Your parts will be easier to remove if you allow your heated bed to cool down to optimal temperature. This will allow the plastic to contract, making it easier to remove.

Once your heated bed has cooled, use the blue handled knife that was included with your toolkit to remove the item. Carefully insert the blade of the knife between your print and heated bed. Once underneath the part rotate the blade lifting with the sharp edge into the part, to gently pop the piece off your plate.
1.9 Full Settings

Full settings should not be used until enough experience with 3D printing has been gained to feel comfortable with all aspects of the printer and its operation. The Quickprint Mode will provide good results for most models. The first time Cura is launched it will default to the Quick Print interface. In order to have more control of your slicing and Gcode generation, switch to Full Settings. Choose your desired Quick Print profile, as you can copy over the current settings when changing to “Full Settings” mode. This will automatically update the settings for that filament. Select Expert > Switch to full settings. The following tabs will now be available: Basic, Advanced, Plugins, and Start/End-Gcode. You will also have access to the Expert Settings.

![Figure 1.13: View in Full Settings](image)

View in Full Settings

When you first switch to Full Settings, Cura will need to know what filament and quality you wish to use. It will automatically transfer our quickprint settings over to allow adjustments if one is selected. **IF A QUICKPRINT PROFILE IS NOT AVAILABLE, YOU WILL NEED TO MANUALLY LOAD ONE.** We recommend using our tested profiles that are available
here: https://www.lulzbot.com/cura. You will want to choose the profile that matches your filament and quality needs. Once downloaded, you can load the file into Cura by selecting File > Open Profile. Choose your desired profile. This will automatically update all of your settings for use with your printer.

### 1.10 Basic Tab Options

Layer Height

The thickness of each printed layer is known as the “Layer Height”. The smaller the layer height, the smoother curves will appear. Larger layer heights are better for bridging and overhangs. Smaller layer heights will also increase print time, as it will take more layers to complete the object.

![Figure 1.14: Differences in Layer Height](image)

Shell Thickness

This defines the number of vertical walls that comprise the outside of your model. We recommend keeping this set to multiples of your nozzle width.
Your TAZ 3D printer is equipped with a 0.5mm nozzle.

Enable Retraction
Retraction tells your printer to pull filament out of the hot end upon travel moves. Travel moves are when your print head moves from one area of the print, to another without laying down filament. We recommend keeping this on for all filament types, and adjusting the retraction length and speed for the specific filament.

Bottom/Top Thickness (mm)
Also known as “Surface Layers” this will determine how thick the top and bottom layers are. A larger number here will create a thicker top and bottom which can be helpful for strength, bridging, and quality purposes. We recommend keeping this number as a multiple of your layer height.

Fill Density
This number is expressed as a percentage. 0% will give a completely hollow print, while 100% will give you a completely solid object. We have found that 20% to 40% fill density is functional for most prints.

Perimeters Before Infill
This option will toggle in what order the infill and perimeters are printed. We recommend leaving this toggled.

Print Speed (mm/s)
Your overall printing speed can be adjusted here. If no other speeds are determined in the later sections your printer will automatically default to this speed. This speed will be different, depending on what type of filament you are using.

Printing Temperature
We recommend leaving this temperature setting to “0”. If you set your temperature in this section your printer will not begin printing until it
reaches the EXACT temperature. We recommend setting your printing temperatures through the Printer Interface, or through your LCD.

Bed Temperature

We recommend leaving this temperature setting to “0”. If you set your temperature in this section your printer will not begin printing until it reaches the EXACT temperature. We recommend setting your bed temperatures through the Printer Interface, or through your LCD.

Support Type

Some models will require support material in order to print properly. This will usually occur when an object has an angle in relation to the build plate between 0 to 45 degrees. It is highly recommended to orient your object so that it minimizes or eliminates the need for support.

Touching Buildplate

This causes the support material to build up between the heated bed and the object. The red example is Touching Buildplate.

Everywhere

This prints support material between the heated bed and object as well as between the object and itself. The green example is Support Everywhere.
Platform Adhesion Type

Some models have a small surface area contacting the plate. This can create adhesion issues causing your part to pop off at some point during the print. To fix this, use either Brim or Raft. Raft is better used when a model has small heated bed contact points and overhangs.

Brim

Brim will create a single layer of filament, contacting and surrounding your model. This will increase the surface area of the part contacting the build platform thereby preventing it from popping off the heated bed. Brim will also help in situations where you are seeing corner lift. Brim settings can be adjusted in the Expert Settings options.

Raft

Raft will generate a layer of material underneath your object. Raft was more often used before the addition of heated plates to increase surface area. Raft settings can be adjusted in the Expert Settings options.
1.1. ADVANCED TAB OPTIONS

Filament Diameter
The filament diameter setting is one of the more important settings. Make sure that you update this value periodically with your average filament diameter. While your filament may be referred to as 3mm, it is more likely going to be near 2.9mm +/- 0.1mm. You will want this to be an accurate average, as it will allow your printer to correctly calculate how much filament it is pulling into the hot end.

Filament Flow %
This controls how much filament your printer is extruding in relation to speed. This setting is mainly used to adjust for filament density variations. Leave this value at 100% as changing it can lead to surface quality issues.

1.11 Advanced Tab Options

Nozzle Size (mm)
This defines your nozzle size. The slicing engine uses this value combined with your other settings to determine how quickly to feed filament into your hot end. The TAZ ships with a 0.5mm nozzle.

Retraction Speed (mm/s)
Retraction Speed determines the speed at which your filament is reversed out of the hot end for travel moves and when changing direction during printing. We recommend keeping this set to 25mm/s or lower.

Retraction Distance
Retraction Distance determines how much filament is pulled out of your hot end on travel moves and when changing direction. You will want to adjust this depending on temperature settings and filament type. Higher thermal retaining filaments such as PLA behave better with a longer retraction distance. We have found anywhere from 1mm to 3mm is a good starting range.
Initial Layer Thickness

This will control how thick your first printed layer height is printed onto the heated bed. Having a larger initial layer height will help prevent your part from popping off the plate. All of our standard profiles have a 0.3mm initial layer height. This eliminates the need for adjustments when switching between filaments.

Initial Layer Line Width

This will control how wide your first extruded filament path is for the initial layer. A wider line width will help with bed adhesion. We have found 125% to be a good starting place. For models with moving printed in place parts, a smaller initial layer line width is recommended.

Cut Off Object Bottom (mm)

This setting is used to help print models that were not specifically designed for FFF printing. In particular, it is for models that do not have a flat surface to adhere to the plate. It will sink your object Xmm into the build plate, creating a nice flat surface to begin your print. You can also use this option to remove the lower portion of your model, or if carefully measured, cut your part in half for printing object as two halves.
1.11. ADVANCED TAB OPTIONS

Dual Extrusion Overlap

This will determine how far your Dual Extruders will overlap when laying down material. This will help adhesion between the two different colors or types of filament. This setting is only used when the printer is equipped with two hot ends and extruders.

Travel Speed

This setting will determine how fast your print head moves while not extruding filament. A normal travel speed of 125 - 175mm/s is recommended.

Bottom Layer Speed

This will control your initial layer speed. In general, a slower initial layer speed will help with first layer adhesion.

Infill Speed

This is how fast your print head speed will be while laying down the interior portion of your model. Faster speeds are usually tolerable here, as none of
the infill will be visible from the outside of your object. If you go too fast compared to your inner and outer shells, you can have adhesion issues or globs of filament left behind from the print head.

**Outer Shell Speed**

This will be the outermost surface of the model. This is the most important speed setting, as it controls the speed of your print head on the visible layers. As a general rule of thumb, the slower you go the better looking print you will get.

**Inner Shell Speed**

This affects vertical walls that are in between the outer shell and infill. This will not be visible but will help support the outer shell and the infill. We recommend keeping this speed setting between your infill and your outer shell speed.

**Minimal Layer Time**

This will determine a minimum amount of time your printer will spend laying down each layer. If your layer print time falls below this your printer will automatically slow down to reach this time before moving onto the next layer. Tweaking this can help get cleaner, crisper prints.

**Enable Cooling Fan**

Enables operation of your extruder active cooling fan. The fan settings can be adjusted in the Expert Settings options.

### 1.12 Plugins

Plugins are custom settings which will alter your print at specific points. The two that come preloaded with Cura are **Tweak at Z**, and **Pause at Height**. More plugins and information can be found here: [http://wiki.ultimaker.com/Category:CuraPlugin](http://wiki.ultimaker.com/Category:CuraPlugin) To activate one of
these highlight the desired plugin and click the drop-down arrow directly below the Plugins box.

![Figure 1.17: View of Plugins](image)

Tweak at Z

Make basic changes at specified Z heights. You can determine the Z height or layer count at which you want to make a change. Then choose how you would like to change your settings. You can alter temperatures, fan speeds, and print speeds. Fine tuning these for specific STL files, can produce cleaner prints.

Pause at Z Height

Pause your print at a specified height. You can also specify where to move the print head and how much filament to retract. This will prevent “blobs” from accumulating on your print while paused. This setting is most commonly used when switching colors of filaments in the middle of a print.
1.13 Start and End Gcode Settings

Custom Gcode allows for complex automatic printer movements and operations. By adding custom Gcode into the start or end of your file, you can alter how it prints. A comprehensive list of Gcode commands can be found here: http://reprap.org/wiki/G-code We recommend new users to leave this as provided in the profiles at https://www.lulzbot.com/cura

1.14 Expert Settings

Expert settings will give you more specific options for your retraction, skirt, active cooling, infill, support, brim, raft, and special settings. To gain access to this section you go to Expert > Open Full Settings or on your keyboard press Control + E.

![Figure 1.18: View Expert Settings](image)

38
1.15 Retraction

Retraction pulls filament out of your nozzle when it is not extruding to prevent your print head from dripping on your object. This section is where you will control how your extruder retracts its filament.

Minimum Travel

This sets the minimum travel distance of your print head in order to retract. If your print head is not moving this far during travel moves, it will not retract.

Combing

This option prevents your print head from traveling over holes in the X/Y plane when printing. This will slightly increase print time, but will prevent strings from getting caught on the holes during travel moves. We recommend keeping this setting on.

Minimal Extrusion Before Retracting

This will prevent a retraction move, if your extruder has not put out Xmm of filament since its last retraction.

Z Hop When Retracting

This will raise your print head Xmm while retracting. This setting helps prevent ooze, and strings from being deposited on your print.

1.16 Skirt

Skirt creates a line around the outside of your object. Most commonly used to prime the extruder, in order to prevent missed filament at the beginning of a print. Leave this setting on.
Line Count
This will define the number of loops the Skirt creates around the outside of your object. Smaller models will require more loops to properly prime the extruder.

Start Distance
This will define the distance away from your model that the skirt will be created.

Minimal Length
This will define the minimum extruded line length for the skirt. This will over ride your line count, producing as many lines as required to reach the minimal length.

1.17 Cool
This section will define how your extruder cooling fan will operate during the print. Your fan will not start until it has reached 25% or higher for speed settings. If your print speeds are slowed down due to minimal layer time, the fan will run between minimum and maximum speed based upon how much the layer is slowed down.

Fan on at Full Height
This is your Z height where your fan will be turned on to its minimum percentage setting. Especially helpful with high temperature retaining filaments such as PLA. This will be scaled between 0%, and your minimum fan speed based upon layer height; with it being disabled for the first layer.

Fan Speed Min
This will be the speed your fan runs when enabled at full height. Once the Z height is reached for Fan on at Full Height, this will be the speed your fan runs at.
1.18. SUPPORT

Fan Speed Max
This is the fastest speed at which your fan will ever run. When your print speed is slowed down due to minimal layer time, your fan will run between minimum and maximum speed. The maximum fan speed is reached when your printer must be slowed by 50% or greater.

1.18 Support
You define how your support material is generated here. You must have some form of support turned on in the basic settings in order for these settings to have an effect.

Structure Type
You can choose between a Grid or a Line pattern for your support material. The grid will be a checkerboard pattern in the X and Y direction. The line option will produce lines in along the y axis for support. The grid will provide stronger support than the line option, but will be harder to remove.

Overhang Angle for Support
This will determine where support material is generated. In general you will be able to print a model with 45 to 90 degree angles in relation to the bed without support. We recommend leaving this setting at 45 degrees.

Fill Amount
This will determine how dense your support material is printed, similar to Infill Percentage. The higher percentage, the better support, but it will be harder to remove the support material, will use more material, and will lead to a larger total printing time.

Distance X/Y
This will determine how far away from your object in the X/Y plane that the support material is being placed.
Distance Z

This will determine how far away your support material is from your object in the vertical direction. A smaller number here makes for better support, but makes it harder to remove.

1.19 Black Magic

This section allows you to transform your model into a hollow shell, a single layer thick.

Spiralize the Outer Contour

This causes your Z axis to be constantly moving upward as printing your single outer wall shell. The results are no layer change lines, giving a much smoother surface. This setting is typically only used for artistic objects as they will be fragile.

Only Follow Mesh Surface

This will cause your print to follow the outside of your model, building it completely hollow with a single wall outer shell. The only difference between this and Spiralize, is that the Z axis moves regularly. That is, it prints a layer and then moves up to the next one.

1.20 Brim

Brim circles the base of the print while making contact, helping adhere the print to the heated plate. This is only one layer thick, and easily removed post-print. This section defines how the brim is formed when brim is activated in basic settings.

Brim Line Amount

This will determine the distance the brim will cover around the outside of your object. The more brim used, the better your part will adhere to the plate.
1.21 Raft

Raft is a platform built underneath your object, designed to help adhesion and prevent warping. It will lay down support material, and then a platform on top of the supports. Your model will be built on top of this platform. The bottom surface of your printed part will not be as clean or as even when using this option. Raft is typically not required.

Extra Margin

This determines the distance around the outside of your object that the raft is created. Can be helpful for ensuring no warping of the lower layers.

Line Spacing

This will determine the spacing between “support” lines for the raft. A small spacing makes the support structures closer together improving strength of the raft, but uses more material.

Base Thickness

This defines how thick your raft will be.

Base Line Width

This will define how wide your “support” material is for the raft. This setting will determine how well the surface layers of the raft print.

Interface Thickness

This will determine how thick the surface layers of the raft are. The surface layers are the platform that is built upon the supports.

Interface Line Width

This will determine how wide the top layers of the platform will be. In general, you can keep this set to your nozzle size, as surface quality of the removable raft is not important.
Airgap
This will define the distance between your raft and your print. A larger gap will make your part easier to remove, but will make the bottom of your print look worse.

Surface Layers
This will determine the number of layers that create the “platform” of your raft. If you have a wide line spacing, you may want to increase this number to ensure a solid platform.

1.22 Fix Horrible
These are some of the more advanced and experimental options. They are designed to help repair models with errors to make them suitable for 3D printing. They do not always work. Please be cautious when using these options as they can have unintended effects on your print quality.

Combine Everything (Type-A)
This will attempt to fix all external mesh errors, while keeping internal holes intact. This can accidentally fill in intentional internal holes.

Combine Everything (Type-B)
This will ignore all internal holes of the model and only focus on the external holes. This is helpful when only the outside finish of the model is important.

Keep Open Faces
This will ignore all manifold errors in the object. It can create issues generating the Gcode as Cura does not know how to interpret the open holes. This option should only be used if you are sure that the holes in the mesh are intended. In general, you should not use this option.
1.23 DUAL EXTRUSION

Extensive Stitching

This causes Cura to automatically add triangle meshes in an attempt to fix manifold errors. This algorithm will greatly increase Gcode generation time and may end up adding in un-intended meshes. It is recommended that you repair your model through MeshLab, FreeCAD or your preferred CAD program before attempting this option.

1.23 Dual Extrusion

The LulzBot TAZ has the ability to add dual extrusion functionality with the Dual Extruder tool head add-on. We only recommend the Dual Extruder tool head for advanced users. Installation and operation of the dual extruder will require you to flash your firmware, calibrate your extruders, level two heads to a single plane, define extruder offsets, and fine tune your slicing profile. This can be a little overwhelming for new users. We recommended that you have a couple of months of single extruder printing experience before making the switch.

Updating Firmware

In order to use the Dual Extruder you will need to update your firmware to activate the second hot end.

- Power on your 3D printer and connect it to your computer through USB.
- Select Machine > Machine Settings.
- In the top right-hand corner you will see a Change Tool Head button, select this.
- Next you will need to select the proper hot end type. Please compare photos with your existing tool head. Choose the correct hot end and select Next.
- Select the photo that corresponds with your tool head and press Next.
The final step will be **flashing the firmware**. Choose **Flash the firmware** to be sure to update the printer's firmware to the proper settings. **This must be done to allow your printer to operate properly.**

Once the progress bar has completed select **OK > Next > Finish**.

You can verify this by looking at the LCD screen. You should now see three temperature readings.

You can revert the firmware back to the stock configuration for your LulzBot™ 3D printer by selecting **Machine > Machine Settings > Change Tool Head**. Doing so will overwrite any of your current firmware settings.

### Calibrating Extruders

Each individual extruder will have its own unique set of Esteps. To determine this, you will need to tell the extruder to take in 100mm of filament.

- Load the outer and inner calibrations squares into Cura [https://www.lulzbot.com/support/downloads](https://www.lulzbot.com/support/downloads)

- Open the Printer Interface window and set temperatures for both heads. Switch between hot ends by entering “T0” for the rear extruder into the command line terminal. Press **enter**.

- Type “T1” for the front extruder into the command line terminal. Press **enter**.

- Make two marks at 100mm and 120mm on the filament from the top surface of each extruder.

- Once at the correct extrusion temperature type into the command line “G92” and press **enter**. Then “G1 E100 F60” and press **enter**.

- Switch to the other tool head by entering “T0” for the rear or “T1” for the front.

- Type into the command line “G92” and press **enter**.

- Type “G1 E100 F60” and press **enter**.
1.23. DUAL EXTRUSION

- Measure the distance that the tool head over or under extruded. You will need to adjust your Esteps by 8 up or down for each mm it under or over extruded.

- Update your Esteps for the rear extruder and E1steps for the front extruder through your LCD screen. **Configuration > Advanced Settings > E/E1 Steps > New Number.** Push in on the knob to exit out of the Esteps entry.

- Store your new Esteps **Configuration > Store Memory.**

Defining Second Extruder Offset

To get crisper looking prints, you will want to really dial in your offsets. With the outer and inner square on your build platform, right click and select **Dual Extrusion Merge.** The red square will be printed with your front extruder, and the yellow square will be printed with the rear extruder.

After printing the squares, you will want to measure Top, Bottom, Left, and Right gap. Enter these numbers into our offset calculator found here: [https://www.lulzbot.com/dual-extruder-calibration-calculator](https://www.lulzbot.com/dual-extruder-calibration-calculator) This will produce new offsets, that will need to be updated in the Machine Settings menu. Repeat as many times as desired to truly fine tune the offset.
First Dual Print

When you are ready to produce your first dual extrusion print, you will need to combine the two separate STL files. One STL file will be for each print head. Left Click on whichever STL you would like printed with the Rear Tool head. Then Right Click on whichever STL file you would like printed with the Front Tool head and select dual extrusion merge. You will now see a single model in two colors on the build plate. The red section will be printed with the front extruder, while the green section will be printed with the rear extruder.

![Figure 1.19: Before Merge](image)
Figure 1.20: After Merge

Setting Dual Temps

After your object has been merged as intended, you will need to set the individual temperatures for each print head. In order to switch between which hot end you are heating, you will need to manually enter T0 to set temps for the rear hot end, and T1 to set temps for the front hot end. The **Bed temp can be set from either T0 or T1.** Once both print heads and the print surface have reached the desired printing temperature select **Print.**
1.24    Printrun

Website: [http://www.github.com/kliment/Printrun](http://www.github.com/kliment/Printrun) The host software, Printrun, can be used to start up and control your 3D printer (Figure 1.22, page 52). The host controls include: setting the extruder and print surface temperatures, manual control of each axis, and manual extrusion. The host is also where you can push print files (.gcode) to the 3D printer or load print files from the SD card for printing out model designs.

Installing Printrun

Printrun contains several different applications that can be used to control the LulzBot™ TAZ 3D printer. It can be installed on Windows, Mac OSX and Linux based computers. Pronterface is the graphical user interface for Printrun. Pronsole allows printing from the command line, and can be used for scripting and some automation. Plater allows you to arrange and combine several STL files into one. More information on the other programs within the Printrun package can be found at [https://github.com/kliment/Printrun](https://github.com/kliment/Printrun). Printrun can be downloaded from LulzBot.com/downloads. Download the version for your operating system and extract. You will need an archive manager to extract the files.
If you do not have one installed we recommend using 7-zip, which can be downloaded for free at www.7-zip.org.

Windows Instructions

- Once downloaded, extract the dist folder to a location of your choice. You can rename the dist folder if you like. Double click pronterface.exe to run Pronterface.

Mac OS X Instructions

- Once downloaded, extract the dist folder to a location of your choice. Once extracted, double click the pronterface-mac.app file to install.

Linux Instructions

Debian|Ubuntu

Recommended Installation

- We recommend using the stand-alone Printrun option found at https://www.LulzBot.com/downloads. Once downloaded and extracted, navigate to the extracted directory. Install the dependencies by issuing the following command in a terminal: sudo apt-get install python-serial python-wxgtk2.8 python-pyglet. Once the dependencies have been installed, run Pronterface by using the following command in a terminal: python prontfacer.py.

Installing from source

- Using Git, in a terminal issue the following command: git clone https://github.com/kliment/printrun.git

- Once downloaded, change to the Printrun directory. You will need to ensure that the following dependencies are met. They are listed in the README.md file. You can use this command to install the dependencies: sudo apt-get install python-serial python-wxgtk2.8 python-pyglet python-tornado python-setuptools
python-libxml2 python-gobject python-pip avahi-daemon libavahi-compat-libdnssd1 followed by: pip install -r requirements.txt To install in a terminal issue the following command: sudo python setup.py install. Run Printrun by issuing the following command: python pronterface.py

Fedora

- Use this command to install Printrun from the official sources: sudo yum install printrun

Archlinux

- Use this command to install Printrun from AUR: yaourt rintrun

1.25 Using Printrun

![Printrun Interface](image)

Figure 1.22: Printrun
Printrun is used to control the printer from a computer. It is divided into 4 main parts: The buttons over the top are used to connect to the printer, load files and start & stop prints.

The movement controls are on the left hand side, with the G-code preview window in the center and the Log window and Terminal command entry box on the right hand side (Figure 1.22, page 52).

Connecting to the your 3D Printer

To start up the printer, first you will need to connect to the printer with Printrun. Make sure you have connected the USB cable from your PC to the printer before launching Printrun. If not, close Printrun, connect the USB cable, and relaunch Printrun. To connect to the printer, select the correct port by using the drop down arrow and selecting the active port, generally \texttt{/dev/ttyACM0}). On other operating systems the port may be named such as \texttt{COM1} or \texttt{tty.usbserial-USB-ID}. The Port button will refresh the Port listing. Once selected choose the default 115200 baud rate and press Connect. Printrun will open a connection to the printer and display firmware information in the Log window.

In the text output window you will see multiple return lines. If you see \textbf{Printer is now online} you have successfully connected to the printer. The printer control buttons on the left will also darken and become clickable after connecting. If nothing is displayed in the Log window verify you have the correct port and connection speed selected. When you need to disconnect the printer simply press the \texttt{Disconnect} button.
3D Printer Software

Figure 1.23: Printrun Functions

Movement

Figure 1.24: Movement Controls
Motors off

Your 3D printer can be moved on all three axes independently. If you would like to do so by hand, use the Motors off button to unlock all the stepper motors. Once unlocked they can be moved by hand. Keep in mind that there is no positional feedback, so if you move an axis you will need to re-home in order to re-establish the hot end’s position.

mm/min XY:/ Z:

These settings control the manual jog speeds when driven with Pronterface. Use caution when changing these figures. Moving the axes too fast can cause the printer to miss steps. If that occurs with the Z axis, it can potentially cause the Z axis to become out of square.

Homing

Caution: when homing, the axis will continue to move in the negative direction until the end stop switch is activated. If the printer is ever transported make sure the end stop switches are clear before resuming printing. If an axis has missed an end stop and is continuing to try to move in the negative direction, immediately turn the power switch to the off position.

Each axes can be homed either individually or together. Press the Home X button to move the X axis to the left until it activates the end stop. Once the X axis end stop is activated, the X axis carriage will ‘bounce’. It will move over and move back to the home position more slowly. Press the Home Y button to home the Y axis. The Y axis platform will move away from you towards the rear of the printer.

X/Y/Z Axes Movement Controls

Prior to moving the X, Y, or Z axis, make sure that you home each axis. The X, Y and Z axes can be moved utilizing the circular movement controls. Each axis can be moved in either fine moves or large moves, ranging from 0.1mm to 100mm. For example, to move the Y Axis towards you, move your mouse to the +y section until both the +y and the 100 are highlighted then select that ring section. To move the Y axis away from you, move your mouse to the -y section until both the -y and the 100 are highlighted.
then select that ring section. The X axis can be moved in a similar fashion.

The Z axis movement control operates similarly, but the movement scale
is different. The Z axis will move in 0.1mm, 1mm and 10mm increments.
The top half of the movement bar will move the Z axis up, by the selected
units, while the lower half will move the Z axis down, by the selected units.

1.26 CAD and 3D Modeling Software

LulzBot is not distributing a CAD or 3D modeling software package. However,
multiple free/libre software packages are available. Other common
non-free CAD and 3D modeling software are also capable of exporting the
required .STL files.

On some CAD and 3D modeling software you will need to select
millimeters as the output unit. If possible it is best to build your 3D design
in metric units rather than imperial units. Slic3r requires .STL files sized
in millimeters. If an .STL with inches as units is loaded into the Slic3r, the
model will be scaled much smaller than expected. You can scale the model
by 2540% to compensate. The software listed below outputs millimeters as
the unit by default.

FreeCAD

Website: http://free-cad.sourceforge.net

Although still in development, FreeCAD is a great free/libre CAD
application. Containing a full GUI for building CAD models, FreeCAD
is capable of creating simple to complex designs. STL files can also easily
be exported for use with 3D printing. FreeCAD is available for GNU/Linux,
Windows, and Mac. The latest development version is recommended.

OpenSCAD

Website: http://openscad.org

OpenSCAD is another free/libre CAD software; however, different than
FreeCAD, it is script based. Rather than using a GUI to generate CAD
designs, OpenSCAD CAD designs are created using script based renderings.
Users with programming experience would find this very useful. Also,
OpenSCAD uses a simple script language that is easy for users with little
or no programming experience to learn.

Blender
Website: http://blender.org

The most widely used free/libre 3D modeling software, Blender is well documented with tutorials available on the Blender.org website as well as found online.

Shapesmith
Website: http://shapesmith.net

Shapesmith is a web-based 3D modeling software. This means there is no required software to get started designing models. Shapesmith is also a great choice for anyone starting out in CAD/ 3D modeling.

1.27 Alternative Printer Host Software

OctoPrint
Website: http://octoprint.org/

Octoprint is a printer host that uses a web-based interface to access and control your 3D printer. Added web-cam functionality allows for time-lapse videos and a live stream. Octoprint will run on Windows, Apple, and Linux based computers and can even run well on a Beagle Bone Black or a RaspberryPi (inexpensive business-card sized computers).

BotQueue
Website: https://www.botqueue.com/

BotQueue works well for those users wanting to have a web-based multiple 3D printer operation running off a queuing system.

MatterControl
Website: http://www.mattercontrol.com/
MatterControl is another printer host that currently runs on Windows and Apple computers. It features 2D and 3D model viewing, a print queue, and print file organization and searching.
Slic3r
2.1 Introduction

Overview

Slic3r is a tool which translates digital 3D models into instructions that are understood by a 3D printer. It slices the model into horizontal layers and generates suitable paths to fill them.

Slic3r is already bundled with the many of the most well-known host software packages: Pronterface, Repetier-Host, ReplicatorG, and can be used as a standalone program.

This manual will provide guidance on how to install, configure and utilize Slic3r in order to produce excellent prints.

This portion of the manual is derived from the complete Slic3r manual. It has been customized for TAZ users. The original unabridged version can be found at manual.slic3r.org. Due to the introduction of Cura LulzBot™ Edition, the recommended printer host and slicer, this abridged Slic3r manual may not be current.

Goals & Philosophy

Slic3r is an original project started in 2011 by Alessandro Ranellucci (aka. Sound), who used his considerable knowledge of the Perl language to create a fast and easy to use application. Readability and maintainability of the code are among the design goals.

The program is under constant refinement, from Alessandro and the other contributors to the project, with new features and bug fixes being released on a regular basis.

Donating

Slic3r started as a one-man job, developed solely by Alessandro in his spare time, and as a freelance developer this has a direct cost for him. By generously releasing Slic3r to the public as open source software, under the GPL license, he has enabled many to benefit from his work.

The opportunity to say thank you via a donation exists. More details can be found at: http://slic3r.org/donations.
2.2 Getting Slic3r

Slic3r is Free Software, and is licensed under the GNU Affero General Public License, version 3.

Downloading

From LulzBot.com

The Slic3r version that has been tested for the TAZ printer can be downloaded from the LulzBot.com downloads page: https://www.lulzbot.com/Slic3r.

Pre-compiled packages are available for Windows, Mac OS X and Linux. Windows and Linux users can choose between 32 and 64 bit versions to match their system.

Slic3r

Slic3r can be downloaded directly from: http://slic3r.org/download.

Pre-compiled packages are available for Windows, Mac OS X and Linux. Windows and Linux users can choose between 32 and 64 bit versions to match their system.

Manual

The latest version of full Slic3r manual, with L\LaTeX source code, can be found at: https://github.com/alexrj/Slic3r-Manual

Source

The source code is available via GitHub: https://github.com/alexrj/Slic3r. For more details on building from source see §2.2 below.

Installing

Linux

Extract the archive to a folder of your choosing. Either:
• Start Slic3r directly by running the Slic3r executable, found in the bin directory, or

• Install Slic3r by running the do-install executable, also found in the bin folder.

The archive file may then be deleted.

Windows
Unzip the downloaded zip file to a folder of your choosing, there is no installer script. The resulting folder contains two executables:

• slic3r.exe - starts the GUI version.

• slic3r-console.exe - can be used from the command line.

The zip file may then be deleted.

Mac OS X
Double-click the downloaded dmg file, an instance of Finder should open together with an icon of the Slic3r program. Navigate to the Applications directory and drag and drop the Slic3r icon into it. The dmg file may then be deleted.

Building from source
For those wishing to live on the cutting edge, Slic3r can be compiled from the latest source files found on GitHub https://github.com/alexrj/Slic3r. Up-to-date instructions for compiling and running from source can be found on the Slic3r wiki.

2.3 First Print

Calibration
Your LulzBot™ TAZ 3D printer was calibrated at the factory prior to packing. TAZ users do not need to calibrate their printers.
If you are just beginning with 3D printing or Slic3r, LulzBot™ recommends starting with our pre-set Slic3r profiles. You can find the TAZ Slic3r profiles at https://www.lulzbot.com/Slic3r. For information on loading and export Slic3r profiles please see page 117. Note that the pre-set profiles will only work correctly when Slic3r is in Expert mode.

The pre-set profiles will give you Slic3r settings that will work great on most designs. The Slic3r manual can be used as a reference in building knowledge of Slic3r settings while using the pre-set profiles. Once you have a number of prints completed you can use the Slic3r manual as a reference to make small adjustments to the pre-set profiles or begin creating your own profiles.
Slic3r has two features to aid newcomers: the configuration wizard, and simple mode.

Sometimes it is nice to have a helping hand when starting out with new software. The configuration wizard asks a series of questions and creates a new configuration for Slic3r.

When using the pre-set TAZ Slic3r profiles you do not need to complete the Configuration Wizard. The Configuration Wizard can be later accessed from the top menu once you are ready to start creating your own Slic3r profiles.

![Configuration Wizard: Welcome Screen](image-url)

**Figure 2.1: Configuration Wizard: Welcome Screen**
1. Firmware Type

The gcode produced by Slic3r is tailored to particular types of firmware. The first step prompts for the firmware that the printer uses. For the TAZ printer select **RepRap (Marlin/Sprinter)**

![Firmware Type](image)

Figure 2.2: Configuration Wizard: Firmware Type
2. Bed Size

This setting defines the maximum distance the extruder may travel along the X and Y axis. The dimensions for the TAZ print surface are X: 298 and Y: 275.

Be sure to measure from the lower left corner where the extruder nozzle rests when are the home position to the maximum distance the nozzle can travel in each direction. Take into account that the X carriage may touch the frame before the nozzle reaches it’s full distance, this will depend on the printer make and model.

![Bed Size Configuration Wizard](image)

*Figure 2.3: Configuration Wizard: Bed Size*
3. Nozzle Diameter

The diameter of the hot-end nozzle is usually clearly displayed either in the description of the hot-end, or in the associated documentation, when the hot-end is purchased. The nozzle sizes available for the TAZ hot end are 0.35mm and 0.50mm.

If the nozzle was home-made, or came from a source without a diameter given, then carefully measure the aperture as accurately as possible. One way of determining nozzle size is to very slowly (1mm/s) extrude some filament into free air and measure the thickness of the resulting extrusion\(^1\). This has the benefit of taking die swell into account, and consequently may be a useful thing to do even if the diameter is known.

\[ \text{Figure 2.4: Configuration Wizard: Nozzle Diameter} \]

\(^1\) http://forums.reprap.org/read.php?1,113374,113953
4. Filament Diameter

For Slic3r to produce accurate results it must know as accurately as possible how much material is pushed through the extruder. Therefore it is vital to give it as precise a value as possible for the filament diameter.

Although the filament used in FDM printers is sold as being either 3mm or 1.75mm this is only a general guide. The diameter can vary between manufacturers and even between batches. Therefore it is highly recommended to take multiple measurements from along a length of the filament and use the average. For example, measurements of 2.89, 2.88, 2.90 and 2.91 would yield an average of 2.895, and so this would be used.

![Figure 2.5: Configuration Wizard: Filament Diameter](image)

Figure 2.5: Configuration Wizard: Filament Diameter
5. Extrusion Temperature

The extrusion temperature will depend on the material, and most can operate over a range of temperatures. The supplier should provide guidance as to which temperatures are suitable. A very general rule of thumb is that PLA lies between 160°C and 230°C, and ABS lies between 220°C and 240°C. More exotic materials will have a different range.

This is one parameter which you will want to fine tune when you start producing prints. The optimal temperature can vary even between colors of the same material. Another factor which may affect the chosen temperature is how fast the extrusion is, where generally faster extrusion runs hotter.

Note: One may choose to control the extruder temperature manually from the printer controller. In this case the temperature can be set to zero.

![Image](image.png)

Figure 2.6: Configuration Wizard: Extrusion Temperature
6. Bed Temperature

If the printer has a heated bed then this parameter may be set. As with the extruder temperature, the value will depend on the material used. A rule of thumb is that PLA requires 35°C - 60°C and ABS requires 85°C.

Note: One may choose to control the bed temperature manually from the printer controller. In this case the temperature can be set to zero.

Figure 2.7: Configuration Wizard: Bed Temperature
2.3. FIRST PRINT

At this stage the wizard is complete and the basic configuration is defined.

![Congratulations!](image)

You have successfully completed the Slic3r Configuration Assistant. Slic3r is now configured for your printer and filament.

To close this assistant and apply the newly created configuration, click Finish.

Figure 2.8: Configuration Wizard: End
The Important First Layer

Before delving into producing the first print it is worthwhile taking a little detour to talk about the importance of getting the first layer right. As many have found through trial and error, if the first layer is not the best it can be then it can lead to complete failure, parts detaching, and warping. There are several techniques and recommendations one can heed in order to minimise the chance of this happening.

Level bed. Having a level bed is critical. If the distance between the nozzle tip and the bed deviates by even a small amount it can result in either the material not lying down on the bed (because the nozzle is too close and scrapes the bed instead), or the material lying too high from the bed and not adhering correctly.

Higher temperature. The extruder hot-end and bed, if it is heated, can be made hotter for the first layer, thus decreasing the viscosity of the material being printed. As a rule of thumb, an additional 5° is recommended.

Lower speeds. Slowing down the extruder for the first layer reduces the forces applied to the molten material as it emerges, reducing the chances of it being stretched too much and not adhering correctly. 30% or 50% of the normal speed is recommended.

Correctly calibrated extrusion rates. If too much material is laid down then the nozzle may drag through it on the second pass, causing it to lift off the bed (particularly if the material has cooled). Too little material may result in the first layer coming loose later in the print, leading either to detached objects or warping. For these reasons it is important to have a well-calibrated extrusion rate as recommended in §2.3).

First layer height. A thicker layer height will provide more flow, and consequently more heat, making the extrusion adhere to the bed more. It also gives the benefit of giving more tolerance for the levelness of the bed. It is recommended to raise the first layer height to match the diameter of the nozzle, e.g. a first layer height of 0.35mm for a 0.35mm nozzle. Note: The first layer height is set this way automatically in simple mode.
Fatter extrusion width. The more material touching the bed, the better the object will adhere to it, and this can be achieved by increasing the extrusion width of the first layer, either by a percentage or a fixed amount. Any spaces between the extrusions are adjusted accordingly.

A value of approximately 200% is usually recommended, but note that the value is calculated from the layer height and so the value should only be set if the layer height is the highest possible. For example, if the layer height is 0.1mm, and the extrusion width is set to 200%, then the actual extruded width will only be 0.2mm, which is smaller than the nozzle. This would cause poor flow and lead to a failed print. It is therefore highly recommended to combine the high first layer height technique recommended above with this one. Setting the first layer height to 0.35mm and the first extrusion width to 200% would result in a nice fat extrusion 0.65mm wide.

Bed material. Many options exist for the material to use for the bed, and preparing the right surface can vastly improve first layer adhesion.

PLA is more forgiving and works well on PEI, PET, Kapton, or blue painters tape.

ABS usually needs more cajoling. While it’s generally preferred to print directly on the PEI surface, a watered-down PVA or white school-glue solution can help prints adhere to the bed and is preferred. Never use anything with acetone on the PEI print surface as it can degrade the PEI material.

No cooling. Directly related with the above, it makes no sense to increase the temperature of the first layer and still have a fan or other cooling mechanism at work. Keeping the fan turned off for the first few layers is generally recommended.
Working with Models

Yet another step lies between now and the first print - a model has to be obtained and then sliced.

Model Formats

Slic3r accepts the following file types.

- STereoLithography (STL) files can come from a wide variety of sources and are now a de facto standard in 3D printing. The files simply describe the surface geometry of a 3D object without any additional information (such as color or material), and it is this simplicity that has probably made the format ubiquitous.

- Wavefront OBJ files are an open format originally used in an animation application from Wavefront Technologies, but has since been adopted by the wider 3D modelling community. It is similar to the STL format.

- Additive Manufacturing File Format (AMF) was developed in response to the limited nature of the STL format. In addition to describing the geometry of the 3D model it can also describe colors and materials, as well as more complex attributes, such as gradient mixes and multiple object arrangements (constellations). Whilst the format is deemed a standard it has yet to be widely adopted in the 3D maker community.

Finding Models

The 3D model files may come from an online repository, such as Thingiverse\(^2\) or GrabCAD\(^3\), or be created from a CAD program, such as FreeCAD\(^4\), Sketchup\(^5\), or OpenSCAD\(^6\), or an online CAD tool such as Shapesmith\(^7\).

\(^2\)http://www.thingiverse.com
\(^3\)http://grabcad.com
\(^4\)http://sourceforge.net/projects/free-cad
\(^5\)http://www.sketchup.com
\(^6\)http://www.openscad.org
\(^7\)http://shapesmith.net
2.3. FIRST PRINT

You may wish to view the files before slicing and there are many free applications available, one of which is Meshlab\(^8\) - a comprehensive tool for viewing and working with 3D files.

Figure 2.9: Shapesmith online CAD tool.

Working with Plater

Slic3r has a tool, called Plater, which allows one or more models to be loaded and arranged before being sliced.

\(^8\)http://www.meshlab.org
Figure 2.10: Plater

Once you have acquired a model, drag it onto the Plater window (or use the Add button below the file list) to load it into Slic3r. In the figure below, the traditional RepRap Minimug\(^9\) is loaded, and is viewed from above. The ring around the model is a skirt - a single perimeter, several millimeters away from the model, which is extruded first. This is useful in making sure the plastic is flowing smoothly from the nozzle when the model is starting to be printed.

\(^9\)http://www.thingiverse.com/thing:18357
2.3. FIRST PRINT

Figure 2.11: Minimug model.

Figure 2.12: STL file loaded.

The model can be repositioned by dragging the representation of it on the left of the screen around the bed. Note that the dimensions of the bed should match your printer, as given during the initial configuration above.
Turn off “Auto-center Parts” in Preferences to position parts where desired.

On the right-hand side is the list of currently loaded files. The buttons along the top of the file list allow you to arrange the models.

- More/Less - Adjust how many copies should be printed.
- 45°/Rotate - Rotate the selected model around the Z axis, either in 45° increments clockwise or counter-clockwise, or by a given amount.
- Scale - Increase or decrease the size of the printed model.
- Split - Divides a model which consists of more than one part into it’s constituent parts, allowing each one to be arranged individually.
- View/Cut - Provides a 3D view.

The buttons along the bottom of the file list allow you to add, remove, auto-arrange, or export the models.

- Add - Opens a file dialog to add a model to the plater, as an alternative to dropping a file directly.
- Delete/Delete All - Remove one or all models from the plater.
- Autoarrange - Attempt to arrange the models to give the optimal layout.
- Export G-code - Starts slicing the model and produces a G-Code file.
- Export STL - Save the current set of models as a single STL file.

Cleaning STLs

If the 3D mesh described in the model contains holes, or edges are misaligned (known as being non-manifold), then Slic3r may have problems working on it. Slic3r will attempt to fix any problems it can, but some problems are out of its reach. If the application complains that a model cannot be sliced correctly then there are several options available: see the chapter about Repairing Models.
Printing

At this stage Slic3r has been configured and a model has been acquired, sliced and made ready for print. Now would be the time to fire up the printer and try it out.

A variety of host software is available to send the G-code to the printer. Amongst the open-source solutions are: Printrun\textsuperscript{10}, Repetier\textsuperscript{11} and Repsnapper\textsuperscript{12}.

The following subsections will cover the options available in expert mode, and look at advanced printing techniques, including special cases and troubleshooting.

2.4 Simple Mode

Simple Mode

Slic3r has two modes of operation, Simple and Expert. These may be chosen from the Preferences window (found under the File menu).

![Preferences](Figure 2.13: Preferences.)

Simple mode offers a reduced set of options, enough for the beginner to get started with. Expert mode gives more control over how Slic3r produces the G-code and will be looked at later.

Print Settings

The Print Settings tab provides the opportunity to change settings related to the actual print. Whereas the other tabs are changed rarely, the settings on this tab will be modified regularly, possibly for each model printed.

\textsuperscript{10}\url{https://github.com/kliment/Printrun}

\textsuperscript{11}\url{http://www.repetier.com/}

\textsuperscript{12}\url{https://github.com/timschmidt/repsnapper}
General. **Layer height** is the thickness of each layer, and it is the step along the vertical axis taken before extruding a new layer atop the previous one. There are several factors that influence how high each layer should be:

- Desired resolution - Lower layer height should result in prints with less noticeable ribs or bands, as each layer is smaller. Aesthetics plays a role here, but also the type of model, for example, a mechanical part may not need such a high resolution finish, whereas a presentation piece may do so.
2.4. SIMPLE MODE

- Print speed - Shorter layers will result in smoother prints but each print will take longer, simply because the extruder must trace the pattern more times. A later goal will be to strike a balance between layer height, the speed of the printer, and the quality of the resulting print.

**Perimeters** defines the minimum number of vertical shells (i.e. walls) a print will have. Unless the model requires single width walls it is generally recommended to have a minimum of two perimeters as this gives some insurance that if a subsection of the perimeter is not printed correctly then the second perimeter will help cover it.

The upper and lowermost layers that sandwich the model are filled with a **Solid layers** pattern. For the bottom layers the important factor to consider is how the surface will look should there be a mistake whilst laying down the first layer, and for this reason it is recommended to have at least two bottom layers.

A similar consideration is required for the top layers. Because the intermediate layers are likely to be filled with a pattern set less than 100% then the covering layers will have to bridge this pattern and this can require more than one pass to cover completely.

![Figure 2.15: An example of insufficient top layers.](image)
Another tip to consider: Setting the top solid layer to zero, and setting the infill also to zero, will result in a hollow receptacle, ideal for turning models into vases for example. Here manipulating the settings within Slic3r can be used to generate different kinds of prints, and not only be used to control surface accuracy.

Figure 2.16: Creating a vase from a solid model.

Infill. **Fill density** is defined on a scale of between 0 and 1, where 1 is 100% and 0.4 would be 40%. For the majority of cases it makes no sense to 100% fill the model with plastic, this would be a waste of material and take a long time. Instead, most models can be filled with less material which is then sandwiched between layers filled at 100% (see **Solid layers** above).

A density value of 0.4 is enough to give almost all models good mechanical strength. A value of 0.2 is usually the minimum required to support flat ceilings.

Slic3r offers several fill patterns which will be discussed in more depth in subsection 2.5 - Infill Choices. Choosing a **Fill pattern** will depend on the kind of model, the desired structural strength, print speed, and personal taste. The more exotic fill methods are usually too slow and unnecessarily complex for most use cases, and so most of the time the infill

http://slic3r.org/blog/tip-printing-vases
2.4. SIMPLE MODE

pattern is either rectilinear, line, or honeycomb. Honeycomb gives the most strength but is slower than both rectilinear or line.

Support material. Printing a model from the bottom up, as with FDM, means that any significant overhangs will be printed in the air, and most likely droop or not print correctly. Choosing support material (Generate support material) will add additional structures around the model which will build up to then support the overhanging part. The Pattern spacing option determines how dense the support material is printed.

![Figure 2.17: An example of an object printed with support material.](image)

Tip: It is sometimes worth considering altering the orientation of the model in order to possibly reduce overhangs.

Raft layers will add additional layers underneath the model and stems from the early days of 3D printing. It can help with prints without a heated bed, or where the bed is not very flat, but it is usually not required and is not recommended. The raft also requires post-processing to remove it.

Speed. In simple mode there are only three speed settings to consider:

- **Perimeters** - The outline of the model may benefit from being printed slightly slower so that the outside skin of the print has fewer blemishes.
• **Infill** - As the infill is hidden this can be extruded a little faster. Take care though not to go too fast as higher speeds results in thinner extrusions, and this may affect how the extrusions bond.

• **Travel** - The jump between the end of one extrusion and the next should usually be performed as quickly as the printer will allow in order to minimise any mess caused by material oozing from the nozzle.

Brim. **Brim width** is used to add more perimeters to the first layer, as a base flange, in order to provide more surface area for the print to stick to the bed with in order to reduce warping (see §2.3). The brim is then cut away once the print is finished and removed from the bed.

Figure 2.18: An example of brim.

Sequential Printing. This feature allows to compose a plate of objects but have the printer complete each one individually before going back to \(Z = 0\) and starting with the next one. See the subsection about Sequential Printing in the Advanced Topics chapter.

Filament Settings

The **Filament Settings** will normally be used infrequently, for example on receipt of a new roll of filament.
2.4. SIMPLE MODE

Filament. The **Diameter** setting will already have been filled from the value given during the wizard (see p.68), but can be updated here.

The **Extrusion multiplier** setting allows the fine tuning of the extrusion flow rate, and is given as a factor, e.g. 1 means 100%, 1.5 would mean 150%. Whilst the value should ideally be set in the firmware it can be useful to test slight changes to the rate by altering this value. It varies the amount of plastic proportionally and should be changed in very small steps (e.g. +/- 0.05) as the effects are very visible.

Temperature. These values are also filled from the wizard, but here the opportunity exists to set the temperature for the first layer (see p.72).

**Printer Settings**

The **Printer Settings** will be updated the least, unless Slic3r is going to be used for many printers, for example, in a 3D printer farm.

---

<table>
<thead>
<tr>
<th>Filament</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Diameter:</td>
<td>2.89mm</td>
</tr>
<tr>
<td>Extrusion multiplier:</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Temperature (°C)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Extruder:</td>
<td>First layer: 0 Other layers: 0</td>
</tr>
<tr>
<td>Bed:</td>
<td>First layer: 0 Other layers: 0</td>
</tr>
</tbody>
</table>

Want more options? Switch to the Expert Mode.

Figure 2.19: Simple Mode: Filament Settings.
Figure 2.20: Simple Mode: Printer Settings.

Size and coordinates. The **Bed size** setting is taken from the wizard (see p.66) and is only used for previewing the model in the plater.

The **Print center** is the point around which the print will be centered. A **Bed size** of 200mmx200mm and a **Print center** of 100mmx100mm would sit the print in the middle. Should it be desired to print away from the center, because of a scratch in the glass perhaps, then this option should be used.

**Z offset** can be used to compensate for an incorrectly calibrated Z end-stop. If the nozzle stops slightly too far from the bed, then adding a
negative value will offset all layers by that amount. The correct solution however is to fix the end-stop itself.

The optimal Z end stop position is where the nozzle tip barely touches the surface of the bed when homed. A sheet of paper makes a good gauge for this very small distance. It is not recommended to use this setting to try and improve layer adhesion, by “squashing” the bottom layer into the bed, instead look at the suggestions in subsection 2.3.

Firmware. As selected in the wizard (see p.65), G-code flavour defines the dialect of G-code generated.

Extruder. Nozzle diameter was defined in the wizard (see p.67).

Retraction. Unless the material being extruded has a very high viscosity it may ooze between extrusions due to gravity. This can be remedied by actively retracting the filament between extrusions. Setting the Length parameter to a positive value will cause the filament to be reversed by that many millimeters before travel. The retraction will then be compensated for by the same amount after the travel move, before starting the new extrusion path.

A value of between 1 and 2mm is usually recommended. Bowden extruders may need up to 4 or 5mm due to the hysteresis introduced by the tube. Setting the Lift Z parameter to a positive value will raise the entire extruder on the Z axis by that many millimeters during each travel. This can be useful to ensure the nozzle will not catch on any already laid filament, however it is usually not necessary and will slow the print speed. A value of 0.1mm is usually sufficient.

Start, End and Layer Chance G-codes. Custom G-code commands can be run before a print starts and after a print finishes. Placeholders can be inserted in the G-code commands\textsuperscript{14}. For example [next\_extruder] would return the index of the next extruder.

The RepRap wiki is a good resource to learn about the variety of G-codes available: \url{http://reprap.org/wiki/G-code}.

Note: Be sure to check that a given G-code is valid for your firmware.

\textsuperscript{14}\url{https://github.com/alexrj/Slic3r/wiki/FAQ#what-placeholders-can-i-use-in-custom-g-code}
The codes specified in **Start G-code** are inserted at the beginning of the output file, directly after the temperature control commands for extruder and bed. Note that if temperature control commands are specified (M104 and M190) then these will replace the temperature G-codes introduced by the **Filament** settings.

Some common G-codes to use before the print starts are:

- G28 - Homes all the axes.

Some common G-codes to use after the print ends are:

- M104 S0 - Sets the extruder temperature to zero.
- M140 S0 - Sets the heated bed temperature to zero.
- G28 X0 - Home the X axis.
- M84 - Disables the motors.

### 2.5 Expert Mode

**Speed**

Once the printer is reliably producing good quality prints it may be desirable to increase the speed. Doing this provides several benefits, the most obvious of which is that the results are produced quicker, but also faster print times can be utilised in producing more layers, i.e. lower layer height, thus improving perceived print quality. An additional benefit is that a faster travel movement, between extrusions, can reduce the effects of oozing.

The best approach is to increment the various speed parameters in small steps and observe the effect each change has on print quality. Travel speed is a safe starting point, and it is not unrealistic to attain speeds of up to 250mm/s (if your printer can handle it). Adjusting the speed of perimeters, infill is available in simple mode, and the general rule is to have the perimeter go a little slower than the infill in order to reduce possible blemishes on the surface (infill can be faster because slight gaps will not matter as much).

Expert mode offers more parameters to fine tune printer speeds. Differentiation between external, small and other perimeters, infill locations,
and bridges and gaps are available, as well as the ability to slow down for the first layer.

<table>
<thead>
<tr>
<th>Speed for print moves</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Perimeters:</td>
<td>90 mm/s</td>
</tr>
<tr>
<td>Small perimeters:</td>
<td>40 mm/s or %</td>
</tr>
<tr>
<td>External perimeters:</td>
<td>70 mm/s or %</td>
</tr>
<tr>
<td>Infill:</td>
<td>100 mm/s</td>
</tr>
<tr>
<td>Solid infill:</td>
<td>100 mm/s or %</td>
</tr>
<tr>
<td>Top solid infill:</td>
<td>50% mm/s or %</td>
</tr>
<tr>
<td>Support material:</td>
<td>60 mm/s</td>
</tr>
<tr>
<td>Bridges:</td>
<td>60 mm/s</td>
</tr>
<tr>
<td>Gap fill:</td>
<td>40 mm/s</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Speed for non-print moves</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Travel:</td>
<td>150 mm/s</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Modifiers</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>First layer speed:</td>
<td>50% mm/s or %</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Acceleration control (advanced)</th>
<th>0 mm/s²</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perimeters:</td>
<td>0 mm/s²</td>
</tr>
<tr>
<td>Infill:</td>
<td>0 mm/s²</td>
</tr>
<tr>
<td>Bridge:</td>
<td>0 mm/s²</td>
</tr>
<tr>
<td>Default:</td>
<td>0 mm/s²</td>
</tr>
</tbody>
</table>

Figure 2.21: Expert mode speed options.

Where indicated a value can be given in percentage. This is in relation to the preceding value, e.g. 50% solid infill would be half of the value defined for infill.

A few general guidelines for each option:

- **Perimeters** - In expert mode this parameter can be increased slightly as the External perimeters option can be used to ensure blemish free external faces.
• **Small perimeters** - Meant for holes, islands and fine details, a slower speed here is recommended.

• **External perimeters** - A slightly slower value may ensure cleaner surfaces.

• **Infill** - As fast as you can without compromising the integrity of the fill structure. Faster extrusions can break and result in weak spots.

• **Solid infill** - The bottom of the model, and any additional solid layers is usually slightly slower than infill but faster than perimeters.

• **Top solid infill** - Allow time for the extrusion to cleanly cover the previous top layers and result in a tidy top surface. The last few layers should have bridged the infill structure nicely, preparing the way for a neat finish.

• **Support material** - Generally support structures are quick and dirty, and so long as the base is adequately supported they can be built as quickly as they can.

• **Bridges** - Having the extrusion span distances depends on the material and cooling. Going too slow will result in sagging, too fast will result in broken strands. Experimentation is the key here, but generally bridging runs slower than perimeters.

• **Gap fill** - Filling in small gaps results in the extruder quickly oscillating and the resulting shaking and resonance could have a detrimental affect on the printer. A smaller value here can guard against this. A setting of zero disables gap filling completely.

• **Travel** - As fast as your printer will allow in order to minimise ooze.

• **First layer speed** - As mentioned in subsection 2.3, the first layer is important to lay down correctly, and a slower pace helps enormously. Setting a value of 50%, or even less, can really help.

**Acceleration control** is an advanced setting allowing acceleration settings for perimeters, infill, bridge, as well as a default setting, to be made. Deciding which values to set depends on the capabilities of the machine. Any settings within the firmware may be a good starting point.
Take into account any restrictions enforced by the firmware as many have settings for the maximum safe speed of each axis.
Infill Patterns and Density

There are several considerations when choosing an infill pattern: object strength, time and material, personal preference. It can be inferred that a more complex pattern will require more moves, and hence take more time and material.

Slic3r offers several infill patterns, four regular, and three more exotic flavours. The numbers given in brackets below each figure are a rough estimate of material used and time taken for a simple 20mm cube model\textsuperscript{15}. Note that this is only indicative, as model complexity and other factors will affect time and material.

\begin{figure}[h]
\centering
\includegraphics[width=0.5\textwidth]{infill-setting.png}
\caption{Infill pattern settings.}
\end{figure}

\begin{figure}[h]
\centering
\includegraphics[width=0.5\textwidth]{infill-line.png}
\caption{Infill pattern: Line (344.51mm / 5m:20s)}
\end{figure}

\begin{figure}[h]
\centering
\includegraphics[width=0.5\textwidth]{infill-rectilinear.png}
\caption{Infill pattern: Rectilinear (350.57mm / 5m:23s)}
\end{figure}

\textsuperscript{15}Taken from http://gcode.ws
2.5. EXPERT MODE

Figure 2.25: Infill pattern: Concentric (351.80mm / 5m:30s)

Figure 2.26: Infill pattern: Honeycomb (362.73mm / 5m:39s)

Figure 2.27: Infill pattern: Hilbert Curve (332.82mm / 5m:28s)

Figure 2.28: Infill pattern: Archimedean Chords (333.66mm / 5m:27s)
Certain model types are more suited for a particular pattern, for example organic versus mechanical types. Figure 2.30 shows how a honeycomb fill may suit this mechanical part better because each hexagon bonds with the same underlying pattern each layer, forming a strong vertical structure.

Most models require only a low density infill, as providing more than, say, 50% will produce a very tightly packed model which uses more material than required. For this reason a common range of patterns is between 10% and 30%, however the requirements of the model will determine which density is best. Figure 2.31 shows how the patterns change as the density increases.
2.5. EXPERT MODE

Figure 2.31: Infill patterns at varying densities. Left to Right: 20%, 40%, 60%, 80%. Top to Bottom: Honeycomb, Concentric, Line, Rectilinear, Hilbert Curve, Archimedean Chords, Octagram Spiral
Slic3r

Infill Optimization

Slic3r contains several advanced infill settings which can help produce better extrusions.

![Advanced settings](image)

**Figure 2.32: Infill advanced settings.**

- **Infill every n layers** - Will produce sparse vertical infill by skipping a set number of layers. This can be used to speed up print times where the missing infill is acceptable.

- **Only infill where needed** - Slic3r will analyse the model and choose where infill is required in order to support internal ceilings and overhangs. Useful for reducing time and materials.

- **Solid infill every n layers** - Forces a solid fill pattern on the specified layers. Zero will disable this option.

- **Fill angle** - By default the infill pattern runs at 45° to the model to provide the best adhesion to wall structures. Infill extrusions that run adjacent to perimeters are liable to de-laminate under stress. Some models may benefit from rotating the fill angle to ensure the optimal direction of the extrusion.

- **Solid infill threshold area** - Small areas within the model are usually best off being filled completely to provide structural integrity. This will however take more time and material, and can result in
parts being unnecessarily solid. Adjust this option to balance these needs.

- **Only retract when crossing perimeters** - Retracting, to prevent ooze, is unnecessary if the extruder remains within the boundaries of the model. Care should be taken if the print material oozes excessively, as not retracting may result in enough material loss to affect the quality of the subsequent extrusion. However, most modern printers and materials rarely suffer from such extreme ooze problems.

- **Infill before perimeters** - Reverses the order in which the layer is printed. Usually the perimeter is laid down initially, followed by the infill, and this is usually the preferable as the perimeter acts as a wall containing the infill.

**Fighting Ooze**

Unless the material being extruded has a very high viscosity it will ooze from the nozzle in between extrusions. There are several settings in Slic3r to which can help to remedy this.

The retraction settings, found in the **Printer** tab, tell the printer to pull back the filament between extrusion moves. This can alleviate the pressure in the nozzle, thus reducing ooze. After the subsequent travel move the retraction is reversed to prepare the extruder for the next extrusion.

![Retraction settings](image)

**Figure 2.33: Retraction settings.**
- **Length** - The number of millimeters to retract. Note that the measurement is taken from the raw filament entering the extruder. A value of between 1 and 2mm is usually recommended. Bowden extruders may need up to 4 or 5mm due to the hysteresis introduced by the tube.

- **Lift Z** - Raises the entire extruder on the Z axis by that many millimeters during each travel. This can be useful to ensure the nozzle will not catch on any already laid filament, however it is usually not necessary and will slow the print speed. A value of 0.1mm is usually sufficient.

- **Speed** - The speed at which the extruder motor will pull back the filament. The value should be set to as quick as the extruder can handle without skipping steps, and it is worth experimenting with this value to find the quickest retraction possible.

- **Extra length on restart** - Adds an extra length of filament after the retraction is compensated after the travel move. This setting is rarely used, however should the print show signs of not having enough material after travel moves then it may be useful to add a small amount of additional material.

- **Minimum travel after retraction** - Triggering a retraction after very short moves is usually unnecessary as the amount of ooze is usually insignificant and it slows down the print times. Set the number of millimeters minimum distance the nozzle must move before considering a retraction. If the printer handles ooze well this can be increased to 5 or 6mm.

- **Retract on layer change** - Movement along the Z axis must also be considered when dealing with oozing, otherwise blobs may occur. It is recommended to leave this setting on.

- **Wipe before retract** - Moves the nozzle whilst retracting so as to reduce the chances of a blob forming.

Additionally there are several settings in the Print tab which can help control oozing.
2.5. EXPERT MODE

- **Only retract when crossing perimeters** (Infill) - Tells Slic3r to only retract if the nozzle will cross the threshold of the current island being extruded. Slight ooze within the walls of a part are not seen and can usually be accepted.

- **Avoid crossing perimeters** (Layers and perimeters - Advanced) - Will force the nozzle to follow perimeters as much as possible to minimise the number of times it must cross them when moving around, and between, islands. This has a negative impact on both G-code generation and print times.

- **Randomize starting points** (Layers and perimeters - Vertical shells) - As the extruder moves up to the start of the next layer any ooze can result in blobs. If the same start point is used for every layer then a seam can form the length of the object. This setting will move the start point to a different location for each layer.

See also subsection: Sequential Printing, on page 120 for another technique which can minimise strings forming between objects.

**Skirt**

The Skirt setting adds an extrusion a short distance away from the perimeter of the object. This can ensure that the material is flowing smoothly from the extruder before it starts on the model proper.

<table>
<thead>
<tr>
<th>Skirt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loops:</td>
</tr>
<tr>
<td>Distance from object:</td>
</tr>
<tr>
<td>Skirt height:</td>
</tr>
<tr>
<td>Minimum extrusion length:</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>6 mm</td>
</tr>
<tr>
<td>1 layers</td>
</tr>
<tr>
<td>0 mm</td>
</tr>
</tbody>
</table>

![Figure 2.34: Skirt settings.](image)

- **Loops** - How many circuits should be completed before starting on the model. One loop is usually sufficient.
• **Distance from object** - The millimeters between the object and the skirt. The default of 6mm is usually sufficient.

• **Skirt height** - The number of layers to lay down a skirt for. For ensuring the material is flowing smoothly, one layer is sufficient, however the skirt function can also be used to build walls around the object in case it should be protected from drafts.

• **Minimum extrusion length** - Dictates a minimum number of millimeters that the skirt should be, should the loop around the object not be enough.

**Cooling**

Temperature plays a key part in determining print quality. Too hot and the material deforms, too cool and layer adhesion may be problematic. Applying cooling will allow the freshly deposited material to solidify enough to provide a good base for the next layer, helping with overhangs, small details and bridges.

There are two main techniques for cooling: adding a fan and slowing down the print speed. Slic3r may choose to use both techniques, using a fan first, and then slowing down the print if the layer time is too fast.
2.5. EXPERT MODE

Figure 2.35: Cooling strategy.

Figure 2.35 shows the strategy adopted by Slic3r. Reading from right to left, when the minimum fan threshold (#2) is reached the fan is turned on. This increases in intensity as the layer time decreases. The print speed remains constant until the estimated print time drops below a certain threshold (#1), this is when the print speed is reduced until it reaches its minimum value.

Fans

Most electronics and firmware allow the addition of a fan via a spare connector. These can then be instructed with G-code, from Slic3r, to turn on or off as the model requires, and to rotate at different speeds.

Care should be taken with the positioning of the fan so that it does not cool any heated bed more than necessary. It should also not cool the heater block of the hot-end so as not to force it to do more work and waste energy. The air movement should aim for the nozzle tip, flowing over the freshly extruded material.
A duct may help in guiding the flow correctly, and there are several designs available online, for a wide variety of printers.

Slowing Down

Slic3r can tell the printer to slow down if the estimated layer time is above a certain threshold.

Care must be taken as the intended effect could be mitigated by the nozzle not moving far enough away from the fresh extrusion, a problem with small, detailed layers. For this reason it is usually recommended to use a fan where possible.

Configuring

In simple mode Slic3r will attempt to choose the optimal settings for both fans and speed. Expert mode gives more granular options.

Figure 2.36: Cooling advanced settings.
2.5. EXPERT MODE

- **Fan speed** - Determines the minimum and maximum speeds - useful for fans that run too fast by default.

- **Bridges fan speed** - As the material stretches over wide gaps, it makes sense to try and cool it as much as possible, therefore a full fan speed is recommended.

- **Disable fan for first \( n \) layers** - Section 2.3 detailed how important the first layer is, and so it makes sense not to apply the fan until sure the print is securely attached to the bed. Keeping the fan turned off for the first two or three layers is a good idea.

- **Keep fan always on** - Overrides any other choices and has the fan run continuously, at least at the minimum speed setting. This can be useful when printing with PLA, but is not recommended for ABS.

- **Enable fan if print time is below \( t \) seconds** - Triggers the fan if the layer will be completed within the given number of seconds.

- **Slow down if layer print time is below \( t \) seconds** - Slows down the print if the layer will be completed within the given number of seconds.

- **Min print speed** - A lower limit on how slowly a layer can be printed.

**Support Material**

Generally, most 3D models will print with overhanging parts by up to a certain degree. The angle is determined by several factors, most notably layer height and extrusion width, and is usually around 45°. For models with larger overhangs a support structure may have to be printed below it. This incurs the use of more material, longer print times, and post printing clean-up.
The first thing to do is activate the support material option by checking the **Generate support material** box. Providing a value of zero to the **Overhang threshold** parameter tells Slic3r to detect places to provide support automatically, otherwise the degrees given will be used. Support generation is a relatively complex topic, and there are several aspects which determine the optimal support, it is strongly recommended to set the threshold to zero and allow Slic3r to determine the support required.

Small models, and those with small footprints, can sometimes break or detach from the bed. Therefore the **Enforce support** option will cause support structures to be printed for the given number of layers, regardless of the angle threshold value.

To demonstrate the infill patterns the minimug model was tilted by 45° along the x axis, as shown in figure 2.38.

---

### Figure 2.37: Support structure options.

<table>
<thead>
<tr>
<th>Support material</th>
<th>Generate support material: ✔</th>
<th>Overhang threshold: 45°</th>
<th>Enforce support for the first: 0 layers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raft</td>
<td>Raft layers: 0 layers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Options for support material and raft</td>
<td>Pattern: rectilinear</td>
<td>Pattern spacing: 2.5 mm</td>
<td>Pattern angle: 0°</td>
</tr>
</tbody>
</table>

---

104
2.5. EXPERT MODE

As with infill, there are several patterns available for the support structure.

Figure 2.38: Minimug model, tilted 45°.

Figure 2.39: Support infill pattern: Rectilinear

Figure 2.40: Support infill pattern: Rectilinear Grid
Figure 2.41: Support infill pattern: Honeycomb

**Pattern Spacing** determines the distance between support lines, and is akin to infill density apart from being defined only in mm. If changing this attribute take into account the width of the support extrusion and the amount of support material that will adhere to the object.

Care should be taken to choose a support pattern which matches the model, where the support material attaches perpendicularly to the wall of the object, rather than in parallel, so it will be easy to remove. If the support structure does run along the length of a wall then the **Pattern Angle** option allows the direction of the support lines to be rotated.

Figure 2.42: Example of pattern angle rotated 45°.

Multiple Extruders

A printer with more than one extruder can be used in different ways: The additional extruder could print a different color or material; or it could be assigned to print particular features, such as infill, support or perimeters.

Multi-material printing requires a suitably designed object usually written in AMF format as this can handle multiple materials (see Model Formats in §2.3). Details on how to create such a file are given below.
2.5. EXPERT MODE

Configuring Extruders

In the Printer Settings tab there is an Extruders option, under Capabilities, which allows the number of extruders to be defined. Incrementing this value will dynamically add another extruder definition to the left-hand pane.

Figure 2.43: Multiple extruder options - Printer Settings Tab (General). Note the two extruders defined in the left-hand pane.

Each extruder can be configured as usual, however there are additional settings which must be set which are particular to multi-extruder setups.

Figure 2.44: Multiple extruder options - Printer Settings Tab (Extruder).
The **Extruder offset** is to be used should the firmware not handle the displacement of each additional nozzle. Your firmware documentation should tell you if this is the case. Each additional extruder is given an offset in relation to the first one. If the firmware does handle this then all offsets can remain at 0,0. We recommend that TAZ users set the extruder offset in Slic3r.

Because the secondary extruder will be dormant whilst the first is working, and vice-versa, it is important that the material is sufficiently retracted to stop oozing. As with the regular retraction settings (see p.97) the **Length** options is measured from the raw filament entering the extruder.

Assigning Filaments

When a printer profile with multiple extruders has been selected the **Plater** tab allows the selection of a different filament for each extruder.

![Figure 2.45: Plater with multiple filament options.](image)

Assigning Extruders for Single-material Objects

For single material prints, where the secondary extruder is to be tasked with a particular extrusion, the **Multiple Extruders** subsection of the **Print**
2.5. EXPERT MODE

Settings tab gives the ability to assign an extruder to each extrusion type.

![Image of Print Settings Tab with multiple extruder options]

Figure 2.46: Multiple extruder options - Print Settings Tab.

Configuring Tool Changes

The Custom G-code subsection of the Printer Settings tab has an option for inserting G-code between tool changes. As with all custom G-code subsections, placeholder variables can be used to reference Slic3r settings. This includes the [previous_extruder] and [next_extruder] variables.
Slic3r

Figure 2.47: Multiple extruder options - Tool change G-code.

Printing Multi-material Objects

If a multi-material AMF file already exists, because the CAD program can export such a format, then this can be loaded into Slic3r in the usual way. The mapping between object materials and extruders is sequential, i.e. the first material is assigned to the first extruder, etc.

Generating multi-material AMF files

Slic3r has the feature to combine multiple STL files into a multi-material AMF file.

- Split the original design into the separate parts within the CAD program, and export each part as STL.
- Within Slic3r, choose Combine multi-material STL files... from the File menu.
- When prompted with a file dialog, choose the first STL, which will be assigned the first material (and hence the first extruder). Click Open to be prompted for the next STL, and so on until each STL is assigned a material. To signal there are no more STL files, choose Cancel.
- The following file dialog prompts for the location and name of the AMF file.

Once generated the file can be loaded and printed as described above.
2.5. EXPERT MODE

Extrusion Width

One reason for modifying the extrusion width has already been discussed: increasing first layer extrusion width in order to improve bed adhesion (see p.73). There are some further cases where it may be beneficial to modify extrusion widths.

- **Perimeter** - A lower value will produce thinner extrusions which in turn will produce more accurate surfaces.

- **Infill and Solid Infill** - A thicker extrusion for infill will produce faster prints and stronger parts.

- **Top infill** - A thinner extrusion will improve surface finish and ensure corners are tightly filled.

- **Support material** - As with the infill options, a thicker extrusion will speed up print time.
It is important to remember that if the extrusion width is expressed as a percentage then this is computed from the Layer height property, and not the Default extrusion width setting.

Variable Layer Height

Slic3r gives the ability to adjust the layer height between arbitrary positions along the Z axis. That is, parts of the model could be printed with a coarse layer height, for example vertical subsections, and other parts could be printed with a finer layer height, for example sloping gradients where layering appears more pronounced.

The model in fig. 2.49 gives a rudimentary example of where variable layer heights could be used to improve print quality. The walls of the structure need not be rendered in high definition for acceptable quality, however the sloping roof shows layer artifacts as the layer height of 0.4mm is too coarse, particularly for the very top, which is flattened. This is shown in the G-Code rendering in fig 2.50.

![Image of a 3D model demonstrating variable layer heights](image.png)

Figure 2.49: Example model highlighting use case for variable layer heights.
The variable layer height options are available by double clicking on a part name in the Plater window. This will cause a pop-up window to be displayed which contains two tabs. The first gives some information about the model, as shown in fig. 2.51.

Figure 2.50: Example with normal layer height.
It is worth noting the height of the model, as this will be useful when calculating the maximum Z height.

The second tab (fig. 2.52) presents a table where each row defines a layer height for a particular range along the Z axis, given in millimeters. In this example the walls of the model are printed at 0.4mm, the steeper parts of the roof are printed at 0.2mm, and the less steep at 0.15mm. Note that each range divides exactly by the given layer height so there are no “gaps” between subsections.
2.5. EXPERT MODE

The resulting G-Code (fig. 2.53) shows a higher definition which should result in a higher quality print.

Figure 2.52: Variable layer height options - Layers.

Figure 2.53: Example with variable layer height.
Fig. 2.54 shows the example model printed. The print on the left has 0.4mm layer height throughout, whereas the print on the right has the variable layer height.

Figure 2.54: Example print with variable layer height.

An additional feature of the variable layers height option is that by entering a zero for a range that part of the model will not be printed. Fig. 2.55 shows the G-Code where layers between 0 and 4mm are skipped. This is a useful way of dividing a tall model into multiple, shorter subsections which can be printed individually and assembled afterwards.

Figure 2.55: Example with skipped layers.
2.6 Configuration Organization

There are two ways in which to organize the configuration settings: exporting and importing the configuration settings, and profiles. The former is available in both simple and expert mode, whereas profiles is only available in expert mode.

Exporting and Importing Configuration

The current set of configuration options can be simply exported via the Export Config File menu option. This saves all the values into a text file with a .ini extension. Previously saved files can be loaded with the Load Config menu option.

This gives a rudimentary means to store different configuration settings for different needs. For example a set with slightly faster print speeds, or a different infill pattern. However this way of organizing things will quickly become frustrating, as each minor change to a parameter may have to be duplicated across many configurations. For this reason, profiles are a more suitable way of managing multiple configurations.

This method also allows configuration to be transferred between machines, or stored remotely.

Profiles

After a few prints it will become apparent that it is worth having a set of configuration options to choose from, and that some parameters change at different rates as others. In expert mode, profiles can be created for Print, Filament and Printer settings, with the expectation that the printer settings change least often, filament rarely, and the print settings could be changed for each model. These different profiles can be mixed and matched as desired, and can be selected either in their respective tabs, or directly from the plater.

Creating Profiles

Open the desired tab and change the settings as necessary. Once satisfied, click the save icon to the left above the setting titles, and give a suitable name when prompted.
Profiles can be deleted by choosing the profile to delete and clicking the red delete button next to the save button.

Figure 2.56: Saving a profile.

Figure 2.57: Deleting a profile.
2.7 Repairing Models

If the 3D mesh described in the model contains holes, or edges are misaligned (known as being non-manifold), then Slic3r may have problems working on it. Slic3r will attempt to fix any problems it can, but some problems are out of its reach. If the application complains that a model cannot be sliced correctly then there are several options available, and the ones described here are all free at the time of writing.

FreeCAD Freecad\(^\text{16}\) is a comprehensive, and free, CAD program which comes with a mesh module, in which repairs to degenerate models can be made. The following steps outline how a problem model file can be analysed and repaired.

- Start FreeCAD and from the start splash page choose **Working with Meshes**.
- Load the model by dragging and dropping it onto the workspace or via the **File** menu. A small message in the bottom left corner will indicate if the model appears to have problems.

\(^{16}\)http://sourceforge.net/projects/free-cad
• From the menu choose **Meshes->Analyze->Evaluate & Repair mesh** to bring up the repair options dialog.

• From the options dialog choose the loaded mesh, then perform each analysis by clicking the **Analyze** button by each problem type, or select **Repetitive Repair** at the bottom to perform all checks. If a corresponding problem is detected the **Repair** button becomes enabled.

• For each desired repair hit the **Repair** button.

• It is important to review the effect the repair script has made to the model. It may be the case that the script damages the file, rather than repair, for example by removing important triangles.

• Export the repaired model via the **Export** menu option or context menu.

### 2.8 Advanced Topics

**Sequential Printing**

When printing several objects at once it can be useful to print each one separately as this will minimise oozing and strings running between the prints. It will also decrease the risk of a problem ruining the entire print - if one part detaches or fails in some way, it will not be dragged into other parts of the print during each layer.

![Sequential printing](image)

*Figure 2.59: Sequential printing options.*

Care has to be taken that the nozzle and extruder does not interfere with already printed parts. Slic3r should warn if it detects the nozzle or extruder will collide with a part, but double check that the layout of the
parts will not cause problems. The Extruder clearance parameters help Slic3r detect potential collisions:

- **Radius** - The clearance that should be given around the extruder. Take care if the extruder is not mounted centrally - take the largest safe value, generally 80mm.

- **Height** - The vertical distance between the nozzle tip and the X axis rods, or lowest part which may interfere with a finished print.

Figure 2.60: The clearance cylinder around an extruder.
Command Line Usage

Slic3r can also be used from the command line instead of via the GUI, as part of a script, or as part of another tool, such as Printrun\(^{17}\).

All options found in the GUI can be used from the command line in the form of switch parameters. The latest version of these are given below, and the most up-to-date information can be found by issuing the command:

```
perl slic3r.pl --help
```

Preset configurations can be loaded from a .ini file using the `--load` option, and options can be overridden further on the command line, e.g.

```
perl slic3r.pl --load config.ini --layer-height 0.25 file.stl
```

Command Line Options

Usage: slic3r.pl [ OPTIONS ] file.stl

```
--help         Output this usage screen and exit
--version      Output the version of Slic3r and exit
--save <file>  Save configuration to the specified file
--load <file>  Load configuration from the specified file. It can be used more than once to load options from multiple files.
-o, --output <file> File to output gcode to (by default, the file will be saved into the same directory as the input file using the --output-filename-format to generate the filename)
-j, --threads <num> Number of threads to use (1+, default: 2)
```

GUI options:
```
--no-plater     Disable the plater tab
--gui-mode      Overrides the configured mode (simple/expert)
```

Output options:
```
--output-filename-format
Output file name format; all config options enclosed in brackets will be replaced by their values, as well as [input_filename_base] and [input_filename_base].gcode (default: [input_filename_base].gcode)
--post-process  Generated G-code will be processed with the supplied script; call this more than once to process through multiple scripts.
--export-svg    Export a SVG file containing slices instead of G-code.
-m, --merge     If multiple files are supplied, they will be composed into a single print rather than processed individually.
```

Printer options:
```
--nozzle-diameter Diameter of nozzle in mm (default: 0.5)
--print-center    Coordinates in mm of the point to center the print around (default: 100,100)
--z-offset        Additional height in mm to add to vertical coordinates (+/-, default: 0)
```

\(^{17}\)https://github.com/kliment/Printrun
2.8. ADVANCED TOPICS

--gcode-flavor The type of G-code to generate
(reprap/teacup/makerbot/sailfish/mach3/no-extrusion, default: reprap)

--use-relative-e-distances Enable this to get relative E values

--gcode-arcs Use G2/G3 commands for native arcs (experimental, not supported
by all firmwares)

--g0 Use G0 commands for retraction (experimental, not supported by all
firmwares)

--gcode-comments Make G-code verbose by adding comments (default: no)

--vibration-limit Limit the frequency of moves on X and Y axes (Hz, set zero to disable;
default: 0)

Filament options:

--filament-diameter Diameter in mm of your raw filament (default: 3)
--extrusion-multiplier Change this to alter the amount of plastic extruded. There should be
very little need to change this value, which is only useful to
compensate for filament packing (default: 1)

--temperature Extrusion temperature in degree Celsius, set 0 to disable (default: 200)

--first-layer-temperature Extrusion temperature for the first layer, in degree Celsius,
set 0 to disable (default: same as --temperature)

--bed-temperature Heated bed temperature in degree Celsius, set 0 to disable (default: 0)

--first-layer-bed-temperature Heated bed temperature for the first layer, in degree Celsius,
set 0 to disable (default: same as --bed-temperature)

Speed options:

--travel-speed Speed of non-print moves in mm/s (default: 130)
--perimeter-speed Speed of print moves for perimeters in mm/s (default: 30)
--small-perimeter-speed Speed of print moves for small perimeters in mm/s or % over perimeter speed
(default: 30)
--external-perimeter-speed Speed of print moves for the external perimeter in mm/s or % over perimeter speed
(default: 70%)
--infill-speed Speed of print moves in mm/s (default: 60)
--solid-infill-speed Speed of print moves for solid surfaces in mm/s or % over infill speed
(default: 60)
--top-solid-infill-speed Speed of print moves for top surfaces in mm/s or % over solid infill speed
(default: 60)
--support-material-speed Speed of support material print moves in mm/s (default: 60)
--bridge-speed Speed of bridge print moves in mm/s (default: 60)
--gap-fill-speed Speed of gap fill print moves in mm/s (default: 20)
--first-layer-speed Speed of print moves for bottom layer, expressed either as an absolute
value or as a percentage over normal speeds (default: 30%)

Acceleration options:

--perimeter-acceleration Overrides firmware's default acceleration for perimeters. (mm/s^2, set zero
to disable; default: 0)

--infill-acceleration Overrides firmware's default acceleration for infill. (mm/s^2, set zero
to disable; default: 0)

--bridge-acceleration Overrides firmware's default acceleration for bridges. (mm/s^2, set zero
to disable; default: 0)

--default-acceleration Acceleration will be reset to this value after the specific settings above
have been applied. (mm/s^2, set zero to disable; default: 130)

Accuracy options:
--layer-height Layer height in mm (default: 0.4)
--first-layer-height Layer height for first layer (mm or %, default: 0.35)
--infill-every-layers Infill every N layers (default: 1)
--solid-infill-every-layers Force a solid layer every N layers (default: 0)

Print options:
--perimeters Number of perimeters/horizontal skins (range: 0+, default: 3)
--top-solid-layers Number of solid layers to do for top surfaces (range: 0+, default: 3)
--bottom-solid-layers Number of solid layers to do for bottom surfaces (range: 0+, default: 3)
--solid-layers Shortcut for setting the two options above at once
--fill-density Infill density (range: 0-1, default: 0.4)
--fill-angle Infill angle in degrees (range: 0-90, default: 45)
--fill-pattern Pattern to use to fill non-solid layers (default: honeycomb)
--solid-fill-pattern Pattern to use to fill solid layers (default: rectilinear)
--start-gcode Load initial G-code from the supplied file. This will overwrite
the default command (home all axes [G28]).
--end-gcode Load final G-code from the supplied file. This will overwrite
the default commands (turn off temperature [M104 S0],
home X axis [G28 X], disable motors [M84]).
--layer-gcode Load layer-change G-code from the supplied file (default: nothing).
--toolchange-gcode Load tool-change G-code from the supplied file (default: nothing).
--extra-perimeters Add more perimeters when needed (default: yes)
--randomize-start Randomize starting point across layers (default: yes)
--avoid-crossing-perimeters Optimize travel moves so that no perimeters are crossed (default: no)
--external-perimeters-first Reverse perimeter order. (default: no)
--only-retract-when-crossing-perimeters Disable retraction when travelling between infill paths inside the same island.
   (default: no)
--solid-infill-below-area Force solid infill when a region has a smaller area than this threshold
   (mm^2, default: 70)
--infill-only-where-needed Only infill under ceilings (default: no)
--infill-first Make infill before perimeters (default: no)

Support material options:
--support-material Generate support material for overhangs
--support-material-threshold Overhang threshold angle (range: 0-90, set 0 for automatic detection,
default: 0)
--support-material-pattern Pattern to use for support material (default: rectilinear)
--support-material-spacing Spacing between pattern lines (mm, default: 2.5)
--support-material-angle Support material angle in degrees (range: 0-90, default: 0)
--support-material-interface-layers Number of perpendicular layers between support material and object
   (0+, default: 0)
--support-material-interface-spacing Spacing between interface pattern lines
   (mm, set 0 to get a solid layer, default: 0)
2.8. ADVANCED TOPICS

--raft-layers Number of layers to raise the printed objects by (range: 0+, default: 0)
--support-material-enforce-layers Enforce support material on the specified number of layers from bottom, regardless of --support-material and threshold (0+, default: 0)

Retraction options:
--retract-length Length of retraction in mm when pausing extrusion (default: 1)
--retract-speed Speed for retraction in mm/s (default: 30)
--retract-restart-extra Additional amount of filament in mm to push after compensating retraction (default: 0)
--retract-before-travel Only retract before travel moves of this length in mm (default: 2)
--retract-lift Lift Z by the given distance in mm when retracting (default: 0)
--retract-layer-change Enforce a retraction before each Z move (default: yes)
--wipe Wipe the nozzle while doing a retraction (default: no)

Retraction options for multi-extruder setups:
--retract-length-toolchange Length of retraction in mm when disabling tool (default: 1)
--retract-restart-extra-toolchange Additional amount of filament in mm to push after switching tool (default: 0)

Cooling options:
--cooling Enable fan and cooling control
--min-fan-speed Minimum fan speed (default: 35%)
--max-fan-speed Maximum fan speed (default: 100%)
--bridge-fan-speed Fan speed to use when bridging (default: 100%)
--fan-below-layer-time Enable fan if layer print time is below this approximate number of seconds (default: 60)
--slowdown-below-layer-time Slow down if layer print time is below this approximate number of seconds (default: 30)
--min-print-speed Minimum print speed (mm/s, default: 10)
--disable-fan-first-layers Disable fan for the first N layers (default: 1)
--fan-always-on Keep fan always on at min fan speed, even for layers that don’t need cooling

Skirt options:
--skirts Number of skirts to draw (0+, default: 1)
--skirt-distance Distance in mm between innermost skirt and object (default: 6)
--skirt-height Height of skirts to draw (expressed in layers, 0+, default: 1)
--min-skirt-length Generate no less than the number of loops required to consume this length of filament on the first layer, for each extruder (mm, 0+, default: 0)
--brim-width Width of the brim that will get added to each object to help adhesion (mm, default: 0)

Transform options:
--scale Factor for scaling input object (default: 1)
--rotate Rotation angle in degrees (0-360, default: 0)
--duplicate Number of items with auto-arrange (1+, default: 1)
--bed-size Bed size, only used for auto-arrange (mm, default: 200,200)
--duplicate-grid Number of items with grid arrangement (default: 1,1)
--duplicate-distance Distance in mm between copies (default: 6)
Sequential printing options:
--complete-objects When printing multiple objects and/or copies, complete each one before
    starting the next one; watch out for extruder collisions (default: no)
--extruder-clearance-radius Radius in mm above which extruder won’t collide with anything
    (default: 20)
--extruder-clearance-height Maximum vertical extruder depth; i.e. vertical distance from
    extruder tip and carriage bottom (default: 20)

Miscellaneous options:
--notes Notes to be added as comments to the output file
--resolution Minimum detail resolution (mm, set zero for full resolution, default: 0)

Flow options (advanced):
--extrusion-width Set extrusion width manually; it accepts either an absolute value in mm
    (like 0.65) or a percentage over layer height (like 200%)
--first-layer-extrusion-width Set a different extrusion width for first layer
--perimeter-extrusion-width Set a different extrusion width for perimeters
--infill-extrusion-width Set a different extrusion width for infill
--solid-infill-extrusion-width Set a different extrusion width for solid infill
--top-infill-extrusion-width Set a different extrusion width for top infill
--support-material-extrusion-width Set a different extrusion width for support material
--bridge-flow-ratio Multiplier for extrusion when bridging (> 0, default: 1)

Multiple extruder options:
--extruder-offset Offset of each extruder, if firmware doesn’t handle the displacement
    (can be specified multiple times, default: 0x0)
--perimeter-extruder Extruder to use for perimeters (1+, default: 1)
--infill-extruder Extruder to use for infill (1+, default: 1)
--support-material-extruder Extruder to use for support material (1+, default: 1)
Post-Processing Scripts

There may be times when the G-Code generated by Slic3r has to be tweaked or modified after it has been created. For this reason there exists the ability to run arbitrary scripts as part of the final steps in the slicing process\(^{18}\).

In the **Output options** subsection of the **Print Settings** tab lies the **Post-processing scripts** option. The absolute path to each script can be added, separated by semicolons. Each scripts should be recognised by the host system, and be executable.

![Output options screenshot](image)

**Figure 2.61: Post-processing script option.**

Each script will be passed the absolute path of the G-Code file that Slic3r generates. All Slic3r configuration options are made available to the scripts by way of environment variables. These all begin with `SLIC3R_`. The following script would write out all Slic3r options to standard output:

```bash
#!/bin/sh
echo "Post-processing G-code file: $*"
env | grep ^SLIC3R
```

**Figure 2.62: Example post-processing script to display Slic3r environment variables.**

Example scripts can be found in the GitHub repository\(^{19}\).

Perl’s in-place mode (`perl -i`) makes it easy to modify the contents of the G-Code file, without having to copy, edit, then replace the original. The following example will simply output the contents to standard output:

```bash
#!/bin/sh
echo "Post-processing G-code file: $*"
env | grep ^SLIC3R
```

**Example scripts can be found in the GitHub repository\(^{19}\).**

---

\(^{18}\)[https://github.com/alexrj/Slic3r/wiki/Writing-post-processing-scripts](https://github.com/alexrj/Slic3r/wiki/Writing-post-processing-scripts)

\(^{19}\)[https://github.com/alexrj/Slic3r/tree/master/utils/post-processing](https://github.com/alexrj/Slic3r/tree/master/utils/post-processing)
#!/usr/bin/perl -i
use strict;
use warnings;

while (<>)
{
    # modify $_ here before printing
    print;
}

Figure 2.63: Example post-processing script to print each line to output.
Understanding extrusion width

Two main questions affect Slic3r’s work:

- How distant should extrusion paths be positioned in order to get a good continuous finish?
- How much material must be extruded along such paths?

If two adjacent paths are too close (or too much material is extruded), they’ll overlap. If two adjacent paths are too distant (or not enough material is extruded), gaps will be visible and/or the extrusions will delaminate because of not enough bonding.

By extruding more or less while moving (i.e. by changing the flow speed/head speed ratio) we can make paths thicker or thinner:

![Figure 2.64: Extrusion Width.](image)

Thicker paths will have better bonding with the lower layer, thus are good for mechanical parts. However, they’ll be less able to approximate the object shape and fill tiny gaps or narrow curves (think of a drill bit: a larger one will not be able to enter narrow places). On the contrary, thinner paths will provide less bonding but better shape accuracy.

However note that extrusion width can be controlled only when extruding over an existing surface (such as a previous layer or print bed). If we extrude in free air (i.e. when bridging), the resulting shape will be always round and equal to the nozzle diameter:
If you reduce the material flow you’ll get smaller circles to some extent, until the plastic viscosity decides it’s time to break your bridge because of too much tension. If, on the contrary, you extrude too much material, the shape of the extruded filament won’t change (still equal to nozzle diameter) but you’ll get a loose bridge.

Let’s start from a definition:

Extrusion Width is the thickness of a single filament extruded either in free air or above a surface. It’s not the distance of two adjacent paths since some overlap will be generally applied in order to get better bonding.

Bridges: the easy case

As said above, there’s only one correct flow rate for bridging: the one that doesn’t make your bridge sag or break. Extrusions are round and their diameter is equal to the nozzle diameter. Parallel paths will be positioned so that they are tangent, thus the spacing between one path and its neighbor is equal to nozzle diameter as well. (In case of bridges, we want no overlap because it has proven to drag the existing paths.)

The required material volume for a path of unitary length is calculated accordingly to the cylindric shape, thus with a circular cross-sectional area:

\[ E = \left(\frac{\text{nozzle\_diameter}}{2}\right)^2 \pi \]

Extruding on top of a surface

In this case the problem is: what shape will our extrusion get? We know it will get squashed horizontally, but will it have a rectangular or oval shape? What’s the maximum extrusion width we can get with a given nozzle diameter before plastic starts curling at the sides?

Slic3r assumes that the cross-sectional shape of an extrusion is a rectangle with semicircular ends. So the relationship between desired extrusion width and volume to extrude is the following:
2.8. ADVANCED TOPICS

When target extrusion width is thinner than layer height the shape is unpredictable so we just use the same rectangular formula but discourage usage of such thin extrusion values.

The above formula provides a function that correlates the target extrusion width with the amount of material to extrude per distance unit:

\[ E = f(\text{extrusion width} \cdot \text{layer\_height}) \]

Spacing paths

How much should we overlap paths in order to get perfect bonding? Supposing no overlap, thus tangent paths, there would be empty space (yellow):

\[ \text{void area} = \text{layer height}^2 - (\text{layer height}/2)^2 \cdot \pi \]
Ideally, we would want to fill all of that yellow area by placing the extrusions closed to each other. However, it’s very unlikely that the second extrusion will fill the space below the previous one, so there would still be a little void. The ideal overlap would be something like:

\[ 0 < \text{overlap factor} \times \text{void area} < \text{void area} \]

with overlap factor ranging from 0 to 1. Overlap factor represents how much void remains between the extrusions. It’s difficult to estimate this amount, since it probably depends also on viscosity of plastic, extrusion speed and temperature. In the past, several values were tried for overlap factor, but some users were still reporting too sparse paths. A value of 1 is currently being used to guarantee that the error (which is always present) is fully on the side of abundant extrusion rather than lacking material.

Path spacing is thus:

\[ \text{spacing} = \text{extrusion width} - \text{layer height} \times (1 - \pi/4) \]

Sane defaults

Slic3r allows users to define extrusion width manually for each kind of extrusion (perimeters, infill, support material etc.) but will calculate sane defaults if no custom values are entered. For the outermost loop of perimeters (aka external perimeters) Slic3r will default to a thin extrusion width, equal to

\[ \text{nozzle diameter} \times 1.05. \]

This is considered the thinnest safe extrusion width. A thin extrusion width provides better accuracy to the object shape and minimizes the flow errors caused by irregular filament.

Extrusion width for other things is calculated by getting the cross-sectional area of the configured nozzle diameter and then calculating the extrusion width produced by extruding that amount of material. In other words, by matching flow speed and head speed. The purpose of this logic is to find the “native” flow that minimizes side forces during extrusion. Such calculated extrusion with is capped to max value equal to:

\[ \text{nozzle diameter} \times 1.7, \] except for internal sparse infill where the full native flow is used.
2.9 Troubleshooting

Dimension Errors

Your TAZ 3D printer has been calibrated and tested prior to leaving our Colorado factory: the steps/mm values for X, Y, and Z axes have been calculated according to your belts, pulleys and leadscrews. Please don’t calibrate by trial-and-error: those values should be exact. Use our standard, known-good values already present in the firmware.

Vertical dimensions

If your vertical dimensions are wrong (i.e. along the Z axis) -and your object is usually shorter than expected- it means your nozzle is too low, thus the first layer is pressed too much on the print bed. To fix this, you might want to raise your Z end stop or increase the Z offset option in Slic3r.

If you encounter vertical dimensions that are half the expected height, make sure that you are using the appropriate firmware for your 3D printer. Instructions on firmware flashing can be found at: https://www.LulzBot.com/Cura.

Horizontal dimensions

The usual issue is about holes being too small. This usually only affects holes on the horizontal plane (XY). There are several reasons for this. Let’s see them one by one:

Plastic shrinkage

Plastic shrinks when cooling. Different kinds of plastic exhibit different shrinkage rates, which might also depend on temperature. Because of such shrinkage, circular (or polygonal) holes laid by the extruder at the nominal diameter will end up smaller after cooling.

More material is deposited in the inside

When you extrude along a curve, more material per distance unit is deposited in the concave side. Such excessive material makes the internal
radius shorter. A compensation algorithm\textsuperscript{20} was proposed by Adrian Bowyer, and it was implemented in Slic3r some time ago but many users complained about holes being too large – it was removed thereafter since smaller holes are better than larger holes since they can be drilled.

Curves are approximated by polygons

STL files only contain meshes composed by flat triangles, so its planar sections can only contain polygonal shapes. For example, a circular hole is approximated by a polygon:

![Figure 2.68: Holes made through polygonal segments.](image)

Increasing the number of segments in your CAD before exporting the STL file will help reducing the error. OpenSCAD users might want to use the \texttt{polyhole()} function developed by nophead\textsuperscript{21} that calculates the optimal number of segments.

Filament tends to cut corners

Since curves are approximated by polygons, there are sharp vertices at their vertices. However, plastic tends to make rounded corners, thus reducing the internal area of the hole even more.

\textsuperscript{20}\url{http://reprap.org/wiki/ArcCompensation}

\textsuperscript{21}\url{http://hydraraptor.blogspot.it/2011/02/polyholes.html}
2.9. TROUBLESHOOTING

Z wobble

Even if the dimensional accuracy of a single layer was correct, several stacked layers might make the hole smaller if they’re not exactly aligned. Z wobble caused by mechanical issues will reduce hole size to the internal envelope of the stacked layers:

Figure 2.69: Z wobble changing layer stacking.

Non-regular filament section

Low-quality and medium-quality filaments are not very regular in diameter. If you measure their diameter along a single meter of them, you’ll often find many different values (and many low-quality filaments are even not perfectly round in section). This continuous variation in diameter will produce irregular flow and the resulting hole will still be the internal envelope of all the layers:

Figure 2.70: Variable filament diameter changing layer stacking.
Backlash

Backlash is a mechanical defect of one or more axes that basically reduces the amount of actual motion whenever a motor inverts its spinning direction. It’s generally caused by loose belts. On printers with a moving bed, its axis (usually Y) is more subject to backlash because of inertia. So, if you get different dimension errors in X and Y, that’s caused by backlash. You’ll need to tighten your belts.

Flow Math

The above causes do not depend on Slic3r and, when possible, they need to be fixed before attempting any software solution.

That said, the flow math used in Slic3r plays a good role in making correct dimensions, since it tries to guess what the shape of the extruded material will be and how thick the extrusion will result on the horizontal plane given an amount of material. Being an approximation, it carries an error. The usual way to deal with these issues involves tuning the Extrusion Multiplier setting in order to increase/reduce the amount of plastic, thus making extrusions more or less thick. But this will also affect solid surfaces, so it’s not the ideal solution.

For more exact dimensions you need to check the External Perimeters First option. Printing external perimeters first will prevent the shift caused by extrudate overlap. On the other hand, printing internal perimeters first hides seams better, so it’s your take.

A new XY Size Compensation option was also introduced that allows to grow/shrink object shapes in order to compensate for the measured error. Supposing your holes are smaller by 0.1mm, you can just enter -0.05 in this option to get them compensated (negative sign means shrink inwards). This is not recommended.

Z Wobble

Undulations in the walls of a print may be due to wobble in the Z axis. A thorough analysis of the potential causes is given by whosawhatsis\textsuperscript{22} in his article “Taxonomy of Z axis artifacts in extrusion-based 3d printing”\textsuperscript{23},

\textsuperscript{22}http://goo.gl/10YoK
\textsuperscript{23}http://goo.gl/ci9Gz
however one point of particular interest for users of Slic3r is the wobble caused by motor steps not matching the pitch of the Z rods thread. This can be addressed by ensuring the Layer Height setting is a multiple of the full step length.

The relevant part of the above paper is quoted here:

To avoid Z ribbing, you should always choose a layer height that is a multiple of your full-step length. To calculate the full-step length for the screws you’re using, take the pitch of your screws (I recommend M6, with a pitch of 1mm) and divide by the number of full-steps per rotation on your motors (usually 200). Microsteps are not reliably accurate enough, so ignore them for this calculation (though using microstepping will still make them smoother and quieter). For my recommended M6 screws, this comes out to 5 microns. It’s 4 microns for the M5 screws used by the i3, and 6.25 microns for the M8 screws used by most other repraps. A layer height of 200 microns (.2mm), for example, will work with any of these because 200 = 6.25 * 32 = 5 * 40 = 4 * 50.
2.10 Slic3r Support

Slic3r Support
A variety of resources are available to provide support for Slic3r.

Wiki and FAQ
The wiki provides up-to-date documentation, and a FAQ subsection which may help resolve any queries or issues.

• https://github.com/alexrj/Slic3r/wiki/Documentation
• https://github.com/alexrj/Slic3r/wiki/FAQ

Blog
The Slic3r blog contains tips, hints, and advice.

• http://slic3r.org/blog

IRC
Found on the irc.freenode.net server, the following chat rooms are often filled with people who can provide real-time help:

• #reprap: Highly active community of the RepRap project with many users of Slic3r.
• #slic3r: Slic3r chat room where Slic3r developers and users can provide help.

RepRap.org Forum
The RepRap forums contain a dedicated forum for Slic3r.

• forums.reprap.org/list.php?263
2.10. SLIC3R SUPPORT

Issue Tracker

If you find a bug in the software, then raise the issue in the project issue tracker.

- github.com/alexrj/Slic3r/issues

Please take the time to read through the existing issues to see whether the problem has already been submitted. Also make sure that the problem is a bug in the application; do not submit support related questions here. If the bug appears to be unreported then please read the bug report guide before submitting: http://git.io/11Hy_w.
Printing with the Graphic LCD
The Graphic LCD allows you to print with the LulzBot™ TAZ 3D printer without needing to have a computer connected or using host software such as Cura. This will allow for more efficient space in the workspace and free up a computer for other tasks.

In the following sections you will find general information on using the Graphic LCD, how to transfer .gcode files to the included SD card, heat up the printer, start a print, and make configuration adjustments.

3.1 GLCD Controller, Cura or Printrun Host?

The Graphical LCD Controller is perfect for normal day to day printing and will be used in the majority of your print jobs. However, in some instances— you will want to use Cura or Printrun instead of the GLCD Controller. A few examples of when you would want to plug the USB cable back in and use Cura:

- A number of manual movements are required to perform calibration checks. Because of this it is easier and faster to make the required manual movements within Cura. Calibration checks can be done with the Graphic LCD, but require a number of repetitive menu selections.

- Printrun offers a number of extra options for advanced users, including custom gcode input, output display, and pronsole. Pronsole is the command line portion of Printrun that can be used in scripts for automation or controlling a printer through remote access, for example, SSH.

- Cura is the preferred printer host software, as the inclusion of quick print profiles, the combination of slicing engine, and printer host communications allows for easy all-in-one use.

3.2 Multiple Connections

Because the LulzBot™ TAZ 3D printer can be controlled by the Graphic LCD and by host software, caution is advised when connecting to the printer through USB as the print can be interrupted when connecting or disconnecting the USB cable. A general rule is: once you have started a print with either the Graphic LCD, Cura, or Printrun, for the rest of the print use only that controller. When printing with the Graphic LCD, never
try to connect through USB in the Cura host software; wait until the print is complete, and then connect in Cura.

3.3 Putting Print Files on the SD Card

To print from the Graphic LCD, you will need to transfer .gcode print files onto the SD card. Follow the normal steps, as explained in the Slic3r chapter, to create .gcode print files on your computer. Insert the SD card into your computer using a SD reader slot or USB SD card reader. Open a file browser or manager and locate the created .gcode files; drag and drop or paste the .gcode files to the SD card. Once the files have transferred, eject the SD card from your computer and insert it back into the SD card slot on the left side of the Graphic LCD case.

Figure 3.1: GLCD Info Screen
3.4 Printing With the Graphic LCD

The Graphic LCD Status Screen

The GLCD screen will turn on you power up your LulzBot™ TAZ 3D printer. The start-up screen will display the Status screen (fig. 3.1, page 143). The Status screen is the default screen for the GLCD, presenting the current status of the printer. There are a number of live statuses shown on the Status screen; these will give you current temperatures, tool head coordinates, print status, and more. The different numbered sections of the status screen are shown in Figure 3.1 above. Follow the key below for more information on each section.

1. Hot end temperatures: represents the current temperature (bottom) and set temperature (top) of up to three nozzles. The RAMBo control electronics currently only supports two hot ends.

2. Heat bed temperature: represents the current temperature (bottom) and set temperature (top) of the heat bed.

3. Fan speed: represents the current optional extruder fan speed. The fan is set to off (1%) by default; the fan is not recommended for ABS. If you print with PLA filament, you will want to use the fan. If cooling is turned on in Cura/Slic3r, this portion of the display will change to reflect the .g-code embedded extruder fan control instructions.

4. Tool head coordinates: represents the current tool head coordinates on the X, Y, and Z axes.

5. Feed rate: represents the current feed rate setting. The feed rate is set to 100% by default; this matches the speed set in the gcode generation. When on, the status screen selection knob can be turned to increase or decrease the feed rate during the print. Increasing/decreasing the feed rate will increase/decrease the speed of the print.

6. Printer status: lists the current status of the printer including: SD card status, current printing file, or completed print time.

7. Current print time: lists the length of time for the current print job.

8. Progress bar: represents the progress of the current print job. The print is finished when the bar is completely white.
Using the Selection Knob

To navigate through the LCD menu use the selection knob by rotating to scroll through selections and pressing the knob to make a selection. From the main Status screen, press the knob to move into the menu screen (Figure 3.2, page 145). To move backwards in the menu tree, select the top most menu selection on the current screen. Selections that will move you backwards through the menu tree are noted by an upwards-facing arrow. Note that if the menu is left idle it will automatically move back to the main Status screen.

Preparation for a Print

Before starting a print you will need to set the hot end and heat bed to the appropriate temperatures for the filament type you are using. To quickly set the printer to preheat, click the selection knob to bring up the menu and select Temperature. Select Filament Type to automatically set the hot end and bed temperature for that specific filament.

If you need to set the extrusion and/or bed temperature to a setting different than the preheat temperature you can manually set the temperature. To do so, from the main menu navigate through: Temperature →
Custom Temp -> Nozzle or Bed. Clicking on either of these settings will give you a menu to set and select the desired temperature setting.

Selecting a File From the SD and Starting a Print

Once the hot end and heat bed have reached the desired temperature the printer is ready to print. From the main menu select the Print from SD option. You will now see a selection of the directories and .gcode files on the SD card. Navigate through the menu to locate the file you would like to print. Select the desired file to begin the print.

Making Manual Movements With the Graphic LCD

As noted previously (page 142), making numerous manual movements is easier done using Cura/Printrun. However, you can make manual movements with the GLCD. Navigate to Movement -> Move Axis. You will select the length of the movement and then which axis to move. Note; that only 1-mm and 0.1-mm movements are allowed for the Z axis and extruder.

When at the move screen; turn the selection knob clockwise to move the axis in millimeters in the positive direction and counter-clockwise for the negative direction.

Configuration Settings

Out of the box, the LulzBot™ TAZ 3D printer is already calibrated for printing. However, the GLCD does allow tuning of the more advanced configuration settings. We highly suggest you not modify the configuration settings unless you are certain it is necessary. These settings control how your printer operates.

The Store Memory and Load Memory functions will store and load the changes you make using the GLCD Controller. You must use the Store Memory function to save the adjusted settings when the printer is powered on. If you ever need to revert to the original factory settings navigate to Control -> Restore Failsafe. Clicking Restore Failsafe will set all configuration settings back to the original factory settings in the firmware.

For more information on the configuration settings please see the LulzBot™ TAZ support page on LulzBot.com.
Maintaining Your 3D Printer
4.1 Overview

Little maintenance is required to keep your LulzBot™ TAZ 3D printer running. Depending on your rate of use, you will want to perform a quick check of your printer every 2 to 4 weeks. The following maintenance guidelines will keep your printer printing quality parts.

4.2 Smooth Rods

Wipe the smooth steel rods with a clean cloth or paper towel. The linear bushings leave a solid lubricant that builds up over time. Hearing squeaking noises while the printer is printing is likely a sign that the smooth rods need to be cleaned. NOTE: Never apply any lubricant or cleaning agent to the smooth rods; the bushings are self-lubricating.

4.3 Lead Screw Drive Rods

Periodically, you will want to wipe down the threaded rods with a lithium-based grease. Never use any petroleum based grease, which may compromise the plastic parts. We utilize Lucas white lithium grease NLGI #2. Apply the lithium grease both above and below the X ends on the threaded rods and wipe down the threaded rods. Use your preferred printer host software or the Graphical LCD controller to drive the Z axis up and down to help further distribute the lubricant. Wipe off any excess.

4.4 PEI Surface

After repeated use, the PEI print surface will begin to need cleaning. To clean the PEI print surface, wipe clean with watered-down Isopropyl Alcohol 10:1 IPA to water ratio and a clean cloth. If you encounter prints lifting from the PEI surface, use a fine grit sandpaper, typically 2000-2500 grit to clean the PEI print surface. We do not recommend printing on bare glass, as it can lead to glass bed damage or failure. Never use acetone to clean the PEI print surface as doing so can damage the film.
4.5 Hobbed Bolt

Filament is pulled through the extruder by a hobbed bolt. After repeated use, the teeth of the hobbed bolt can become filled with plastic. Using the brush or pick from the printer kit, clean out the hobbed bolt teeth. If an extruder jam ever occurs, remove the plastic filament from the extruder and clean out the hobbed bolt.

4.6 Belts

Over long periods or after extensive relocating of the printer you may need to re-tighten the belts on your 3D printer. For the X axis, using the 2.5mm hex driver, loosen one of the belt clamps. The belts clamps are located on the X axis carriage. To loosen the belt clamp, loosen the M3 screws on the clamp. Using the needle nose pliers, pull the belt tight. While holding the belt tight, tighten down the M3 screw. The Y axis belt can be tightened using the same steps as the X axis using the belt clamps found on the bottom of the Y axis plate. Make sure not to over tighten the belts as this can cause unneeded stress on the printer.

4.7 Hot End

The hot end should be kept clean of extruded plastic by removing melted plastic strands with tweezers. If melted plastic builds up on the hot end nozzle you can clean it with a paper towel moistened with acetone or IPA. Make sure the hot end is completely cool before attempting to wipe clean the nozzle with acetone.

4.8 Electronics

The electronics case holding the RAMBo board may need dust blown out occasionally. Power down the printer and use the provided 2.5-mm driver to remove the four M3 screws securing the lid. The fan is mounted to the lid and connected to the RAMBo board. Be careful with the fan cable during removal. Once removed, use short bursts of compressed air to blow out any dust. Plug in the lid fan, paying attention to polarity, and reattach.
the lid.
Advanced Usage
5.1 Intro

After you become familiar with printing using the default settings, a few advanced techniques may help in getting better and more consistent prints from the LulzBot™ TAZ 3D printer. Some of these instructions are items and materials not included with the TAZ. With any of these additional items or materials, follow safety and usage guidelines as instructed by the manufacturer.

5.2 Changing nozzles

The LulzBot™ TAZ 3D printer is available with a tool head equipped with a 0.50mm nozzle. The tool head with the 0.50mm nozzle diameter will print faster than a 0.35mm nozzle tool head. Layer heights of 0.05mm to 0.50mm are possible with the standard 0.50mm tool head. Due to the specific torque- 30 ft/lb- required to tighten the nozzle when removed we do not recommend removing the nozzle from the LulzBot™ Hexagon Hot End. Failure to properly tighten the nozzle to the specific recommended torque may lead to leaks or damage if over-tightened. Nozzle related issues will not be covered under warranty after nozzle changes. We recommend having the other nozzle diameter tool head/hot end on hand for quick, easy, and simple changes.

5.3 Bed Adhesion

You may find that during printing, printed parts lift off the print surface on the corners. If you are seeing this turning on Brim in Cura or Slic3r will help increase the surface area of the print, improving part adhesion. If the corners of the part still lift, clean the PEI surface with IPA/ Isopropyl Alcohol and sand the surface with fine grit (2000-3000) sandpaper. While almost all 3D printing filaments will adhere well to the PEI print surface, Nylon print adhesion can be improved with the application of a PVA glue solution/gluestick. Flexible filaments such as Ninjaflex can adhere too well and can be released easier from the PEI print surface with an application of a PVA glue solution/gluestick to the heated bed prior to starting the printing process.
5.4. USING 1.75MM FILAMENT

ABS/Acetone Glue

Acetone is not included or required with the LulzBot™ TAZ 3D printer. Acetone and ABS solution is NOT recommended anymore, as the PEI print surface works well without it.

Gluestick/PVA Glue solution

While almost all 3D printing filaments will adhere well to the PEI print surface, Nylon print adhesion can be improved with the application of a PVA glue solution/gluestick. Flexible filaments such as Ninjaflex can adhere too well and can be released more easily from the PEI print surface with an application of a PVA glue solution/gluestick to the heated bed prior to starting the printing process.

5.4 Using 1.75mm filament

Your LulzBot™ TAZ 3D printer is set up to use 3mm plastic filament by default and may be capable of printing 1.75mm filament with no hardware modification. While many of our advanced users are able to do so, your results may vary. More information can be found in our User Forums at: https://forum.lulzbot.com/viewtopic.php?f=16&t=1923
Hardware and Software Source Code
The LulzBot™ TAZ 3D printer is a free/libre hardware design. All of the source files are available at http://download.lulzbot.com/TAZ including:

- The latest version of this document, with \LaTeX source code.
- 3D models and print files for all of the printed parts in .stl, .gcode, and other original source files.
- 3D calibration objects and random novelties.
- Production file for calculating large print runs.
- Design files for all electronics and machined parts.
  - LulzBot™ Hexagon hot end
  - RAMBo electronics
  - Various spec sheets
- Bill of materials including every part needed to build the printer.
  - TAZ
  - LulzBot™ Hexagon
- Drawings of components.
  - Aluminum extrusions
  - LulzBot™ Hexagon
  - Bed plate
- Software binaries and source code for GNU/Linux and others. Also includes known good configuration files.
  - Cura
  - Slic3r
  - Printrun
  - Marlin
3D Printer Support
7.1 LulzBot

For common technical support questions for your TAZ 3D printer please visit lulzbot.com/support. Also, visit forum.lulzbot.com for support and tips from the LulzBot™ 3D printer community. If you have further questions, e-mail our support team at support@lulzbot.com. Please completely read this manual before contacting for support questions or help. The latest version of this information guide is also available at http://download.lulzbot.com. You can also find more information including images, videos, and updated versions of this manual in the Support section of LulzBot.com.

7.2 Community

Community Support and Resources

- LulzBot™ 3D printer forum: forum.lulzbot.com
- IRC chat rooms on the irc.freenode.net server.
  - #reprap: Highly active community chat room where help can easily be found
  - #slic3r: Slic3r chat room where Slic3r developers and users can give help
- RepRap.org forums: forums.reprap.org
Warranty Information
8.1 Warranty

Warranty information for your LulzBot™ TAZ 3D printer can be found at LulzBot.com/support/return-policy

Extended Warranty

Contact Information
9.1 Support

Email: support@LulzBot.com
Phone: +1-970-377-1111 x610

9.2 Sales

Email: sales@LulzBot.com
Phone: +1-970-377-1111 x600

9.3 Websites

Aleph Objects, Inc., the makers of LulzBot™
3D Printers:
www.AlephObjects.com
LulzBot™ 3D Printers and parts:
www.LulzBot.com
forum.LulzBot.com
Symbols
1.75mm filament, 153

A
ABS, 153
acetone, 149, 153
Adhesion Type, 32
Advanced Options, 33
advanced techniques, 152
Airgap, 44
aluminum extrusions, 156
AMF, 74
Apple OS X, 15, 56, 57

B
Base Line Width, 43
Base Thickness, 43
Basic Options, 29
baud rate, 53
bed adhesion, 153
bed plate, 156
Bed Temperature, 31
belts, 149
bill of materials, 156
binaries, 61
Black Magic, 42
Blender, 57
blog, 138
BotQueue, 57
bottle, 152
Bottom Layer Speed, 35
Bottom Thickness, 30
Bridge, 130
Bridging, 130
Brim, 18, 32, 42
brim, 152
burns, x
bushings, 148

C
CAD, 56
Calibrating Extruders, 46
calibration, 62, 156
Combine Type-A, 44
Combine Type-B, 44
Combing, 39
command line, 122
community support, 138, 158
configuration
   export, 117
   import, 117
Configuration Wizard, 64
connecting, 53
Cooling, 40
cooling, 100
   fans, 101
   slowing down, 102
Cura, 15, 156
INDEX

Custom Gcode, 38
Cut Off Object, 34

D
Dimension Errors, 133
download, 15, 61, 156
drive rods, 148
driver, 15
Dual Extrusion, 45
Dual Extrusion Overlap, 35

E
electronics, x, 149, 156
Enabling Cooling Fan, 36
end stops, 55
Expert Settings, 38
extended warranty, 160
Extensive Stitching, 45
Extra Margin, 43
extruder, x, 49
extruder jam, 149
extruders
    multiple, 106
extrusion, 49
Extrusion Overlap, 129
Extrusion Shape, 130
Extrusion Width, 129, 130
extrusion width, 111

F
fan, 149
Fan Settings, 40, 41
FCC, xi
filament, 18
Filament Diameter, 33
Filament Settings, 84
    Cooling
        Bridges fan speed, 103
Disable fan for first n layers, 103
Enable fan if print time is below t seconds, 103
Fan speed, 102
Keep fan always on, 103
Min print speed, 103
Slow down if layer print time is below t seconds, 103
Filament, 85
    Diameter, 68, 85
    Extrusion multiplier, 85
Temperature
    Bed, 70, 85
    Extruder, 69, 85
    Fill Amount, 41
    Fill Density, 30
First Dual Print, 48
First Layer, 72
First Print, 25
Fix Horrible, 44
Flow Math, 129
Flow Rate, 33
forums, 138, 158
FreeCAD, 56, 119
Freenode, 138, 158
Full Settings, 28

G
g-code, 14
gcode, 14, 49, 156
Ghost, 23
GitHub, 61
glass, 148
GLCD, 25
Gluestick, 153
gluestick, 153

164
GNU/Linux, 15, 56, 57
Graphical LCD controller, 25
grease, 148

H
hardware, 156
hazards, x
heater block, x
Hexagon, 156
hexagon, 156
High Detail, 17
high resolution, 152
High Speed, 18
hobbed bolt, 149
Host, 57
hot end, 149, 152

I
infill, 92, 96
Infill Speed, 35
Initial Layer, 34
Initial Layer Width, 34
Inner Shell Speed, 36
Installation, 15
Interface Line Width, 43
Interface Thickness, 43
IPA, 152
IRC, 138, 158
Isopropyl Alcohol, 148
Isopropyl alcohol, 152

L
latex, 156
Layer Height, 29
layer height, 112
Layers, 24
lead screw, 148
license, 61
Line Count, 40
Line Spacing, 43
Load Model, 18
lubricant, 148

M
maintenance, 148
Marlin, 156
Material Selection, 18
MatterControl, 57
Menu
  Combine multi-material STL files..., 110
Minimal Layer Time, 36
Minimal Length, 40
Minimum Travel, 39
models, 74
  finding, 74

N
Ninjaflex, 152
novelties, 156
nozzle, 152
Nozzle Size, 33
Nylon, 152, 153

O
OBJ, 74
OctoPrint, 57
ooze, 97
Open Faces, 44
OpenSCAD, 56
operating system, 15
Orientation, 18
Outer Shell Speed, 36
Overhang, 22
Overhang Angle, 41

P
Paths, 131
Pause at Z Height, 37
PEI, 152
PEI surface, 148
Plater, 75, 108
Plater, 49
Plugins, 36
Port, 53
Post processing, 127
Power supply, x
Print Settings, 79
   Brim, 84
      Brim width, 84
Infill, 82
   Fill angle, 96
   Fill density, 82, 92
   Fill pattern, 82, 92
   Fill Top/bottom fill pattern, 92
   Infill before perimeters, 96
   Infill every n layers, 96
   Only infill where needed, 96
   Only retract when crossing perimeters, 96, 98
   Solid infill every n layers, 96
   Solid infill threshold area, 96
Layer height, 80
Multiple Extruders, 108
Output options
   Post-processing scripts, 127
Perimeters, 81
Sequential printing
   Extruder clearance, 120
Skirt and brim
   Skirt, 99
Solid layers, 81
Speed, 83, 89
   Acceleration control, 90
   Bridges, 89
   External perimeters, 89
   First layer speed, 89
   Gap fill, 89
   Infill, 83, 89
   Perimeters, 83, 89
   Small perimeters, 89
   Solid infill, 89
   Support material, 89
   Top solid, 89
   Travel, 83, 89
   Support material, 83
      Enforce support, 104
      Generate support material, 83, 104
      Overhang threshold, 104
      Pattern, 104
      Pattern Angle, 106
      Pattern Spacing, 106
      Pattern spacing, 83
      Raft layers, 83
Print Speed, 30
Printed parts, 156
Printer Host, 14
Printer Settings, 85
   Custom G-code
      End G-code, 87
      Start G-code, 87
      Tool change G-code, 109
   Extruder
      Extruder offset, 108
      Nozzle diameter, 67, 87
   Firmware
      G-code flavour, 65, 87
      Size and coordinates, 86
      Bed size, 66, 86
      Print center, 86
      Z offset, 86
INDEX

Printing, 79
printing, 26
Printing from SD, 25
Printing from USB, 26
Printing Temperature, 30
Printrun, 49, 52, 53, 156
profiles, 117
create, 117
delete, 118
pronsole, 49
pronterface, 49
PVA, 153

Q
Quick Print Profile, 17
Quick Print Settings, 17

R
Raft, 32, 43
RAMBo, 149, 156
Removing a Print, 27
RepRap, 138, 158
Resolution, 17
Retraction, 30, 39
retraction, 97
Retraction Distance, 33
Retraction Speed, 33

S
Sane Defaults, 132
scripting, 122
scripts, 127
SD, 25
SD card, 25, 49
Second Extruder Offset, 47
Sequential Printing, 120
Setting Dual Temps, 49
Shapesmith, 57
Shell Thickness, 29
simple mode, 79
Skirt, 39
skirt, 99
Slic3r, 156
Slicers, 14
Slicing, 14
smooth rods, 148
software, 14, 56, 57, 156
Source Code, 61, 156
speed, 88
Spiralize, 42
Standard Quality, 18
Start Distance, 40
static, xi
STL, 18, 56, 57, 74, 156
cleaning, 78
stl, 49
Support, 41, 42
Support Material, 18, 41
support material, 103
Support Settings, 41
Support Type, 31
Surface Layers, 44

t
technical support, 158
temperature, x, 49, 100
Temperatures, 27
terms and conditions, 160
threaded extension, 152
threaded rods, 148
Top Thickness, 30
Travel Speed, 35
Tweak at Z, 37

U
Updating Firmware, 45
USB cable, 53
INDEX

V
View Options, 21

W
warnings, x
warping, 152
warranty, 160
website, 138
Windows, 15, 51, 56, 57
wires, x

X
Xray, 23

Z
Z hop, 39
Z Wobble, 136
Glossary

.gcode The file extension for G-Code files

3D Printer Also referred to as additive manufacturing, is the process of fabricating objects from 3D model data, through the deposition of a material in accumulative layers.

ABS Acrylonitrile butadiene styrene thermoplastic. Usually extrudes at 230C with the Budaschnozzle and 245C with the LulzBot™ Hexagon Hot End.

Acetone A colorless, volatile, flammable liquid ketone, (CH3)2CO, used as a solvent for ABS.

Baud Rate Refers to the speed at which the host controller communicates with the 3d Printer electronics.

CAD Computer Aided Design

Cura Cura is a cross-platform software package that combines a slicing engine with a printer host interface.

Filament Plastic material in a “string” like form, as it is fed to the printer.

free/libre Free/Libre hardware and software can be thought of as “free as in free speech, not just free as in free beer”, although most Free/Libre software is available for no cost. Libre hardware designs can be copied, modified and are usually available for download. Free/Libre software can be used in a similar fashion.

GCODE The common name for the most widely used CNC programming language.

HDPE High-density polyethylene.
Heater block Machined from aluminum, the heater block generates heat with a heater resistor and uses a thermistor to measure the temperature. 
Heater resistor A special type of resistor that is used to apply heat in a small area. 
HIPS High-impact polystyrene. Usually extrudes at 230°C with the Budaschnozzle and 230°C with the LulzBot™ Hexagon Hot End 
Hot end The hot end is the whole part where the plastic melts, including the nozzle, heater block, thermistor, and heat sink. The LulzBot™ Hexagon Hot End comes standard on the TAZ 5. 

Layer height The thickness of each individual deposited layer of the three-dimensional model when cut with a slicing program. 
Laywoo-D3 Wooden filament similar to PLA. Forty percent of its content consists of recycled wood. Usually prints at 180°C to 210°C. Color can be changed by varying the extrusion temperature. 

Nozzle The metal tip at the bottom of the hot end. It has a small hole where the plastic filament comes out of the printer. 

PLA Polylactic acid is a corn-based biodegradable polymer. Usually extrudes at 185°C with the Budaschnozzle and 205°C with the LulzBot™ Hexagon Hot End. 

Polycarbonate A strong and impact-resistant thermoplastic. Usually extrudes at 300°C. 

PTFE Polytetrafluoroethylene is a synthetic fluoropolymer used in the Budaschnozzle for it’s low coefficient of friction. This limits the Budaschnozzle top extrusion temperature to 250°C. The LulzBot™ TAZ 5 does not use a hot end with a PTFE insert and can reach a 300°C extrusion temperature. 

PVA Polyvinyl acetate is the main ingredient in white glue, wood glue and the common school glue stick. 

Resolution In general terms, the resolution you print at can be determined by the layer height you use. The LulzBot™ TAZ can print at a layer height of 0.05mm to 0.50mm. 

Slic3r Slic3r is a cross-platform 3D model slicing engine. It’s used to process the 3 dimensional model into the Gcode (tool path) needed to physically generate the print.
GLOSSARY

Spool Plastic filament coiled and stored on a plastic reel. Preferred over 1.75mm filament due to improved feeding and better mounting options.

Thermistor A special type of resistor that changes resistance based on temperature. It is used to measure temperature on the nozzle and the heated bed.

Threaded extension Used to separate the heater block and nozzle from the PEEK insulator. The plastic filament passes through the threaded extension into the melting chamber.
Colophon

Created with 100% Free/Libre Software
GNU/Linux
\LaTeX Memoir